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Chapter 1. Global

Rice Client Overview

Y ou can integrate your application with Rice using several methods, each described below.

Embedded

This method includes embedding some or al of the Rice services into your application. When using this
method, a standalone Rice server for the Rice web application is still required to host the GUI screens and
some of the core services.

To embed the various Rice modules in your application, you configure them in the RiceConfigurer using
Spring. For more details on how to configure the RiceConfigurer for the different modules, please read
the Configuration Section in the Technical Resource Guide for the module you want to embed.

Figure 1.1. Diagram of a sample embedded implementation
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* Integration of database transactions between client application and embedded Rice (via JTA)
» Performance: Embedded servicestalk directly to the Rice database

» No need for application plug-ins on the server
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» Great for Enterprise deployment: It's still a single Rice web application, but scalability is increased
because there are multiple instances of embedded services.

Disadvantages
» Can only be used by Java clients
» Morelibrary dependencies than the Thin Client method

» Requires client access to the Rice database

Bundled

This method includes the entire Rice web application and all services into your application. This method
does not require a standalone Rice server.

Each of the Rice modules provides a set of JSPs and tag libraries that you include in your application.

These are then embedded and hooked up as Struts Modules. For more details on how the web portion of
each module is configured, please read the Configuration Guide for each of the modules.

Figure 1.2. Diagram of a sample bundled implementation
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Advantages

« All the advantages of Embedded Method
» No need to deploy a standalone Rice server
* |ded for development or quick-start applications

» May ease development and distribution
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 Can switch to Embedded Method for deployment in an Enterprise environment

Disadvantages

* Not desirable for Enterprise deployment when more than one application isintegrated with Rice

* More library dependencies than the Thin Client method and the Embedded Method (since it requires

additional web libraries).

Thin Java Client

This method utilizes some pre-built classes to provide an interface between your application and web

services on a standalone Rice server.

Many of the Rice services are exposed by the KSB as Java service endpoints. This means they use Java
Serialization over HTTP to communicate. If desired, they can also be secured to provide access to only

those callers with authorized digital signatures.

Figure 1.3. Diagram of a sample Thin Java Client implementation
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» Relatively simple and lightweight configuration

» Fewer library dependencies

Disadvantages

» No transactional integration between client and server
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 Plug-ins must be deployed to the server if custom Rice components are needed

Web Services

This means directly using web services to access a standal one Rice server. This method utilizes the same
services as the Thin Java Client, but does not take advantage of pre-built binding code to access those

services.

Advantages

» Any language that supports SOAP web services can be used

Disadvantages

» No transactional integration between client and server

* Plug-ins must be deployed to the server if custom Rice components are needed

» Web Services can be slower than other integration options

Global Configuration Parameters

Table 1.1. Global Configuration Parameters

Configuration Parameter Description Sample value
app.code Together with environment, forms the app.context.name which then | kr

forms the application URL.
application.id Theunique ID for the application. A value should be chosen which will

be unique within the scope of Kuali Rice deployment and integration.

There is no default for this value but it must be defined in order for

portions of Kuali Rice to function properly.
application.host The name of the application server the application is being run on. localhost
application.http.scheme The protocol the application runs over. http

cas.url

The base URL for CAS services and pages.

https://test.kuali.org/cas-stg

config.obj file

The central OJB configuration file.

config.spring.file

Used to specify the base Spring configuration file. The default value is
"classpath:org/kuali/rice/kew/config/K EW SpringBeans.xml"

credential sSourceFactory

The name of the
org.kuali.rice.core.security.credentials.Credential sSourceFactory bean
to use for credentials to calls on the service bus.

datasource.accessToUnderlying
ConnectionAllowed

Allows the data source's pool guard access to the underlying data
connection. See: http://commons.apache.org/dbcp/apidocs/org/apache/
commong/dbcp/BasicDataSource.html
#isAccessToUnderlyingConnectionAllowed()

true

datasource.initial Size The initial number of database connections in the data source pool. | 7
See:  http://commons.apache.org/dbcp/api docs/org/apache/commons/
dbcp/ BasicDataSource. html#initial Size

datasource.minldle The number of connections in the pool which can be idle without | 7
new connections being created. See: http://commons.apache.org/dbcp/
apidocs/org/apache/commons/dbcp/ BasicDataSource.html#minidlie

datasource.ojb.sequenceManager. The class used to manage database sequences in databases

className which do not support that feature. Default value is
"org.apache.ojb.broker.platforms.K ualiMySQL SequenceM anager mpl"|
datasource.pool.maxActive The maximum number of connections alowed in the data|50

source pool. See: http://commons.apache.org/dbcp/apidocs/org/apache/
commong/dbcp/ BasicDataSource.html#maxActive
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Configuration Parameter Description Sample vaue
environment The name of the environment. This will be used to determine if | dev

the environment the application is working within is a production

environment or not. It is also used generally to express the "name" of

the environment, for instance in the URL.
http.port The port that the application server uses; it will be appended to all URLs| 8080

within the application.

log4j.settings.props

The log4j properties of the application, set up in property form.

log4j.settings.xml

Thelog4j properties of the application, set up in XML form.

rice.additional SpringFiles

A commadelimited list of extra Spring filestoload when theapplication
starts.

additional .config.locations

A comma delimited list of additional configuration file locations to
load after the main configuration files have been loaded. Note that this
parameter only applies to the Rice standalone server.

rice.custom.ojb.properties

The file where OJB properties for the Rice application can be found.
The default is "org/kuali/rice/core/ojb/RiceOJIB.properties’

org/kuali/rice/core/ojb/RiceOJB.properties

rice.cache.disableAllCaches

Flag to disable all Spring caching in Rice

false

rice.cache.disabledCaches

Flag to disable specific Spring cachesin Rice by name. The cachenames
should be comma separated.

http://rice.kuali.org/kim/v2_0/PermissionType, http://
rice.kuali.org/kim/v2_0/TemplateType{ Permission}

ricelogging.configure

Determines whether the logging lifecycle should be loaded.

false

rice.url

The main URL to the Rice application.

${ application.url} /kr

security.directory The location where security properties exist, such as the user name and | /usr/local/rice/
password to the database.

transaction.timeout The length of time a transaction has to complete; if it goes over this| 300000
value, the transaction will be rolled back.

version The version of the Rice application. 03/19/2007 01:59 PM

Rice Service Architecture and Configuration

Overview

This document describes how the Rice Service Architecture operates.

Overview

The Rice System consists of astack of Resourceloader objectsthat contain configuration information and
expose service implementations (potentially from remote sources). Each module supplies its own Spring
context containing it's services. These Spring contexts are then wrapped by a Resourcel oader which is
used to locate and load those services.

Implementation Details

Rice is composed of a set of modules that provide distinct functionality and expose various services.
Each module loads it’ s own Spring context which contains numerous services. These Spring contexts are
wrapped by a Resourcel oader class that provides access to those services. A Resourcel oader is similar
to Spring's BeanFactory interface, since you acquire instances of services by name. Rice adds several
additional concepts, including qualification of service names by namespaces. When the RiceConfigurer
isinstantiated, it constructs a Global Resourcel oader which contains an ordered chain of Resourcel oader
instances to load services from:
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Figure 1.4. Resour ce L oader Stack
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All application code should use the Global Resourcel. oader to obtain serviceinstances. The getService(...)
method iterates through each registered Resourcel. oader to locate a service registered with the specified
name. In it's default configuration, the Global Resourcel. oader contacts the following resource loaders in
the specified order:

1. Spring Resour cel oader —wraps the spring contexts for the various Rice modules
2. Plugin Registry —allows for services and classes from to be loaded from packaged plugins

3. Remote Resourcel oader — integrates with the KSB ServiceRegistry to locate and load remotely
deployed services

As shown above, the last Resourcel.oader on the list is the one registered by KSB to expose services
available on the service bus. It's important that this resource loader is consulted last because it gives
priority to using locally deployed services over remote services (if the serviceis available both locally and
remotely). Thisis meant to help maximize performance.

Accessing Rice Services and Beans Using Spring

Rice Service as a Spring Bean

In addition to programmatically acquiring service references, you can also import Rice services into a
Spring context with the help of the Resourcel oader ServiceFactoryBean:

- inport a Rice service fromthe ResourceLoader stack -->
<bean i d="aRi ceService" class="org. kuali.rice.resourcel oader. support. ResourcelLoader Servi ceFact oryBean"/ >

This class uses the Global Resourcel. oader to locate a service named the same as the ID and produces a
bean that proxies that service. The bean can thereafter be wired in Spring like any other bean.

Using Annotations

Riceincludes a Spring bean that extends the Spring auto-wire process (unlike the current version of Spring,
the auto-wire process in the version of Spring that's included with Rice cannot be extended). With this
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bean configured into your application, you can use the @RiceService annotation to identify Rice services
to auto-wire.

Add this bean definition to the top of your Spring configuration file to configure the Spring extension:

<bean class="org. kuali.rice.core.util.GRLServicelnjectionPostProcessor"/>

Add the @RiceService annotation to any field or method, following the normal Spring rules for injection
annotations. The annotation requires aname property that specifiesthe name of the serviceto inject. If the
name requires a namespace other than the current context namespace, you must specify the namespace as
aprefix (for example, “{ KEW} actionListService”).

@Ri ceSer vi ce(name="wor kf | owDocunent Servi ce")
protected Workfl owDocunent Ser vi ce wor kf | owDocunent Ser vi ce;

Publishing Spring Services to the Global Resource Loader

In certain cases, it may be desirable to publish al beans in a particular Spring context to
the Resource Loader stack. Fortunately, there is an easy way to accomplish this using the
RiceSpringResourcel oaderConfigurer as shown below:

<!— Publish all services fromthis Spring context to the GRL -->
<bean cl ass="org. kuali.rice.core.resourcel oader. R ceSpri ngResour ceLoader Confi gurer"/>

<bean i d="nyServi cel" class="ny. app. package. MyServicel"/>

<bean i d="nyServi ce2" class="ny. app. package. MyServi ce2"/>

In the above example, both myServicel and myService2 would be added to a Resource L oader that would
be put at the top of the Resource Loader stack. The names of these services would be “myServicel” and
“myService2” with no namespace. To load these services you would use the following call to the Global
Resource L oader:

MyServi cel nyServicel = d obal Resour celLoader . get Servi ce(“myServicel”);

Customizing and Overriding Rice Services

Reasons for Overriding Services

The most common reason that one would want to override services in Kuali Rice is to customize the
implementation of a particular service for the purposes of institutional customization.

A good example of thisisthe Kuali Identity Management (KIM) services. KIM is bundled with reference
implementations that read identity (and other) data from the KIM database tables. In many cases an
implementer will already have an existing identity management solution that they would like to integrate
with. By overriding the service reference implementation with a custom one, it’ s possible to integrate with
other institutional services (such as LDAP or other services).

Installing an Application Root Resource Loader

An dternative to using the RiceSpringResourcel.oaderConfigurer to publish beans from a Spring context
to the Rice Resource Loader framework is to inject aroot Resource Loader into the RiceConfigurer.

Y ou can create an implementation of Resourceloader that returns a custom bean instead of the Rice bean,
or you can use abuilt-in resource loader like the SpringBeanFactoryResourcel oader which wrapsa Spring
context in a Resourcel oader. Y our configuration needs to inject this bean as the RootResourcel oader of
the RiceConfigurer using the rootResourcel oader property, as shown below:

<l-- a Rice bean we want to override in our application -->
<bean i d="overriddenRi ceBean" class="ny. app. package. M/Ri ceServi cel npl "/ >
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<!-- supplies services fromthis Spring context -->
<bean i d="appResour ceLoader"
class="org. kuali.rice.core.resourcel oader. Spri ngBeanFact or yResour ceLoader"/ >

<bean id="rice" class="org.kuali.rice.core.config.Ri ceConfigurer">
<property name="r oot Resour ceLoader" ref="appResourceLoader"/>

</ bean>

Warning
Application Resource Loader and Circular Dependencies

Be careful when mixing registration of an application root resource loader and lookup of Rice
servicesviathe Global Resourcel oader. If you are using an application resource loader to override
aRicebean, but one of your application beans requiresthat bean to beinjected during startup, you
may create acircular dependency. In this case, you have to make sure you are not unintentional ly
exposing application beans (which may not yet have been fully initialized by Spring) in the
application resource loader, or you have to arrange for the GRL lookup to occur lazily, after
Spring initialization has completed (either programmatically, or via some sort of proxy).

Replacing Rice Configuration Files

A Rice-enabled web application (including the Rice Standalone distribution) contains a RiceConfigurer
(typicaly defined in a Spring XML file) that |oads the Rice modules. Y ou can override services from the
various modules by injecting alist of additional spring filesto load asin the following example:

<bean id="rice" class="org.kuali.rice.core.config.Ri ceConfigurer">

<property name="additional SpringFiles" ref="appResourceLoader">

<list>

<val ue>cl asspat h: nmy/ app/ package/ MyCust onSpri ngFi | e. xml </ val ue>

</list>

</ property>

</ bean>

Y ou will need to ensure that any Spring XML filesand necessary classesthey reference arein the classpath
of your application. If you are overriding things in the Rice standlone application itself, then you would
need to place classes in the WEB-INF/classes directory of the war and any jars in the WEB-INF/lib
directory.

It's a standard behavior of Spring context loading that the last beans found in the context with a particular
id will be the versions loaded during context initialization. The additional SpringFiles property will put
any Spring files specified at the end of the list loaded by the RiceConfigurer. So any beans defined in that
file with the same id as beans in the interna Rice Spring XML files will effectively override the out-of-
the-box version of those services.

When working with the packaged Rice standalone server, you won't have access to the Spring XML
file which configures the RiceConfigurer. In this case, you can specify additional spring files using a
configuration parameter in your Rice configuration XML, asin the following example:

<param nane="ri ce. addi ti onal Spri ngFi |l es”
val ue="cl asspat h: ny/ app/ package/ MyCust onSpri ngFi | e. xm "/ >

Eclipse and Rice

Warning

Recent changein Eclipse setup
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Due to its unreliability, we have recently stopped relying on the Maven plugin for Eclipse to
manage the project build path. Instead, we are using the eclipse:eclipse plugin for Maven to
generate a static build path. Please note the changes in the Eclipse project setup.

Overview

This document describes how to set up an Eclipse environment for running Rice from source and/or for
developing onthe Kuali Rice project. To create your own Kuali Riceclient application, seetheinstructions
in Creating a Rice-Enabled Application.

Download the Tools

1. Install Java5 SDK - http://java.sun.com.

2. Install the Eclipse Europa Bundle for Java Developers - http://www.eclipse.org/europal

* You need to alocate at least 768MB of memory for the Eclipse runtime and at least 512MB of
memory for the VM that Eclipse uses when it runs Java programs and commands.

» Goto Eclipse Preferences.
* On Windows: Window --> Preferences--> Java --> Installed JREs.
* On Mac OS X: Eclipse --> Preferences --> Java --> Installed JREs.
+ Select the JRE and click Edit.
* Add-Xmx768m to Default VM Arguments

3. Install Maven2 for command line usage:
» Download Maven2.0.9 from http://maven.apache.org/download.html.

* Install Maven2 into C:\maven on Windows or /opt/maven on Linux. This directory is called the
Maven Root directory.

* Register Maven on your computer's PATH so that it can be invoked as an executable without have
to run the mvn command from the <maven_r oot>/bin directory all of the time.

» SettheM2 HOM E environment variable on your system to thelocation of your Maven2 installation.

4. Update .m2 repository directory (WINDOWS ONLY') By default (on Windows) maven places the.m2
repo directory in the user directory inside the Documents and Settings folder. The space characters
can cause issues. To avoid them we need to do the following:

a. Figure out where you want your local maven repository to be stored, i.e. C:\work\m2
b. Make sure you turn off eclipseif it has auto updating maven turned on.

c. Move everything from your old maven directory to your new one. Thiswill save you a considerable
amount of time. If you do not do thisthen maven will re-download all repositoriesto the new location.

d. Update your settingsxml file. This should be located in C:\Documents and Settings\user
\.m2\settings.xml. Add this line to the file somewhere inside the <settings> tag:

<l ocal Reposi t or y>C: \ wor k\ n2</ | ocal Reposi t ory>
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Import rice into Eclipse as a project (Source distribution
only)

Note: You only need to follow these instructions if you downloaded the source distribution of Rice asa
zip file. If you are a contributing developer who will be committing code to CV'S, please skip this step
(Importing riceinto Eclipse as a Project) and go to the next one instead.

1. Open Eclipse.

2. Choose File --> Import --> Existing Projects into Workspace.
Figure 1.5. Root Directory Selection
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3. Browse for and select /java/pr ojects/rice (or where ever you unzipped the source distribution to) as
the root project directory and click Finish.
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Figure 1.6. Root Directory Selection Continued
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Check out the Rice code (Non-source SVN distribution

only)

Note: You do not need to perform the stepsin this section if you have downloaded the source distribution
of Riceasazipfile.

1

2.

3.

We recommend installing Subclipse as a plugin from your Eclipse instance (http://subclipse.tigris.org/
install.html)

Set up anew SV N repository in Eclipse: http://svn.kuali.org/reposirice

Check out the Rice code from the appropriate branch of code (i.e. branches/rice-rel ease-1-0-0-br)

Set up database drivers

Oracle

1. If thisisthe first time you've set up Eclipse to work with Rice, Maven won't find the Oracle drivers
in the Kuali repository.

2. If you do not already have an Oracle driver saved in /java/drivers as ojdbcl4.jar, you can download
one from http://www.oracle.com/technol ogy/software/tech/java/sqlj_jdbc/index.html. Saveit as/java/
drivers/ojdbcld.jar

3. Run this command from the command line (this should al be on one line when you enter it):

UNIX
m/n install:install-file -Dgroupld=comoracle -Dartifactld=ojdbcl4

-Dversi on=10. 2. 0. 3. 0 - Dpackagi ng=jar -Dfile=/javal/drivers/ojdbcl4.jar

Windows

nvn install:install-file -Dgroupld=comoracle -Dartifactl|d=ojdbcl4
- Dversi on=10. 2. 0. 3. 0 - Dpackagi ng=jar -Dfile=c:/javal/drivers/ojdbcl4.jar

Or, run the equivalent Ant target:

ant install-oracle-jar
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Other databases

The driver for MySQL is already referenced by the Kuali Rice project. Rice does not have out-of-the-box
support for other RDBMS at this point in time. However, if you want to use other databases, it is possible
to add database support for that particular database as long as it’s supported by the Apache OJB project
(http://db.apache.org/ojb).

Set up Eclipse for Maven
If this is the first time you are using Eclipse with a project build path generated by the eclipse:eclipse
Maven plugin, you need to define the M 2_REPO Classpath Variable in your Eclipse: Java > Build Path
> Classpath Variable, under the Preferences menul.

Figure 1.7. Eclipse Classpath Variables
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The Rice project contains auto-generated build path entries that rely on the presence of this M2_REPO
variable to determine the location of dependency libraries.

Rebuild Rice

1. If dependency libraries have been added or removed from the Rice project, including the first time you
check out Rice, you should run the retrieve-maven-dependencies Ant target to pull down all necessary
libraries.
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Note: For the Maven2 Ant tasks to work, Ant has to know where your Maven2 homeis. If you have
set the M2_HOME variable in your system environment, it will be recognized automatically. If not,
or if for some reason you want to use a different location (e.g., if you want to have multiple Maven
installations), then you can set the maven.home.dir ectory property in /root/kuali-build.properties.

2. Add the build.xml file in the root of the Rice project to your Ant view, or open a shell to the Rice
project directory and run the retrieve-maven-dependenciestarget. Y ou should see Maven retrieving any
required dependencies. If you are running this Ant task in Eclipse, then you must recognize the PATH
environment variable under Run > External Tools > Open External Tools Dialog > Environment.

3. Optionaly, if you have trouble running this Ant target, you can just run an mvn compile from the
command line to invoke a Maven compilation. This will download all dependencies into your local
maven repository.

4. Execute a clean build of the project in Eclipse:

Figure 1.8. Eclipse Clean Build
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5. If your build was previously broken due to the M2_REPO classpath variable being undefined or due
to missing libraries, it should now have been built successfully.

Install the database

To set up the database, please follow the instructions in the Installation Guide under Preparing the
Database.
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Installing the appropriate configuration files

Note: Be sure to use an appropriate editor such as vi or Notepad when editing configuration files. For
example, we have found that WordPad can corrupt the configuration file.

To install the configuration file for the Kuali Rice sample application, you can do an Ant-based setup or
amanual setup.

Ant-based setup

1. Executethe prepare-dev-environment Ant target in thebuild.xml filelocated in theroot of the project.

2. Thiscreates: <user home>/kuali/main/dev/sample-app-config.xml

Manual setup

1. Copy the configitemplates/sample-app-config.templatexml file to <user home>/kuali/main/dev/
sample-app-config.xml.

» For Windows, your user home is: C:\Documents and Settings\<user name>
» For Unix/Linux, your user homeis: /home/<user name>
» For Mac OS X, your user homeis; /User g/<user name>
2. Add the appropriate database parameters to <user home>/kuali/main/dev/sample-app-config.xml

* Oracle

<par am name="dat asour ce. ur| ">j dbc: oracl e: t hi n: @ ocal host: 1521: XE</ par an>
<par am nanme="dat asour ce. user name" >or acl e. user nane</ par an>
<par am name="dat asour ce. passwor d" >or acl e. passwor d</ par an»>

* MySQL

<par am name="dat asour ce. url ">j dbc: nmysql : / /1 ocal host: 3306/ kul ri ce</ par an>
<par am name="dat asour ce. user name" >nysql . user name</ par an
<par am name="dat asour ce. passwor d" >nmysql . passwor d</ par an>

Run the sample web application

» Back in Eclipse, locate and run the rice - JettyServer.launch file:
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Figure 1.9. Eclipse Jetty Launch
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« Point your browser to the following url: http://localhost:8080/kr-dev

Changing Rice project dependencies

If you change any of the dependenciesin any of the Rice pom.xml files, you must run the update-eclipse-
classpath Ant target to regenerate the top-level Eclipse .classpath file for the project.
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Figure 1.10. Update Eclipse Classpath
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If you change the dependencies and commit the change, when others update their local source copy they

must run the corresponding retrieve-maven-dependencies target again.

Note

Refresh your Eclipse project if dependencies (and therefore the Eclipse.classpath file) have

changed.

Other Notes

Settings.xml warning

If thisisthe first time that you have installed the Maven plugin into your Eclipse environment, you may

need to add afile called settings.xml in your <user home>/.m2 directory.

The easiest way to tell if you need to do thisis that there will be awarning in the console after building,
stating that the settings.xml fileismissing. All you need to do is create a settings.xml file with this content:

Rebuild, and the warning should no longer appear.

Note

You do NOT ever need to run any of the context menu Maven commands from inside Eclipse.

You do NOT need to run any Maven commands from the command line.

The Eclipse Maven2 plugin is a little bit flaky sometimes. Y ou might need to close Eclipse to

flush its memory.

Default workspace JDK not 1.5

If your default workspace JDK is not 1.5, you need to reconfigure the Maven external tools definitions

for Rice thisway:
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1. Open Run->External Tools->External Tools Dialog... menu item.
2. Find the m2 build category.

3. Select each preconfigured Rice external tool configuration, select the JRE tab, and ensure the JRE is
setto 1.5.

Using a custom maven repository location

The default Maven2 repository location is in your user directory; however, if you have a pre-existing
repository (or for some other reason don't want it in your user directory), you can alter Maven2'srepository
location. The current version of the Maven2 plugin has a bug that does not allow this to work (see http://
jira.codehaus.org/browse/MNGECL IPSE-314), but the 0.0.11 development version available from the
update site http://m2eclipse.codehaus.org/update-dev/ allows you to specify a custom local repository.

Note

If you make this change, you may have to delete and re-add the Maven Managed Dependencies
library to your project build path if you have an existing, invalid, Maven-managed dependencies
library.

Setting JDK Compliance version

If your default workspace JDK is not 1.5, then you also need to set the JDK compliance level to the
appropriate version for the project. You can find this by right-clicking on the Project -> Properties ->
Java Compiler -> Compiler compliance level. Be sure the Enable project specific settings checkbox is
checked.

Turn off validation

Be sureto turn off validation at the project level by right-clicking on the Project, then clicking Properties
-> Validation -> Suspend all Validators. This can be adjusted once a successful Rice project is up and
running.

ORA-12519, TNS:no appropriate service handler found

If you start seeing java.sql.SQL Exception: Listener refused the connection with thefollowing error:
ORA-12519, TNS:no appropriate service handler found, there are a couple of things that may remedy
the problem.

1. Increase the Oracle XE connection limit:

alter system set processes=150 scope=spfile;
alter system set sessions=150 scope=spfile;

2. Lower the pool sizein your rice config.xml:

<par am name="dat asour ce. pool . maxSi ze" >10</ par an>

Disconnect any other clients and then restart Oracle-XE.

Creating Rice Enabled Applications

Creating a Rice Client Application Project Skeleton

In order to install a Rice client as a standalone server, please see the installation guide instructions for
Standalone Server Setup section in the Installation Guide.
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Reorder Eclipse Classpath

Once you have completed the installation, you will need to import your project into eclipse and reorder the
eclipse classpath to account for a change in how the classpath was generated by maven. Navigate to your
project properties and select the Order and Export tab from the Java Build Path project property. There
will be an entry for JRE System Library at the bottom of the list that should be moved to the very top.

Rice Configuration System

The Rice Configuration System is an XML-based solution which provides capabilities similar to Java
property files, but also adds some additional features. The configuration system lets you:

» Configure keys and values

» Aggregate multiple files using a single master file

* Build parameter values from other parameter values
» Usethe parametersin Spring

» Override configuration values

Configuring Keys and Values

Below is an example of a configuration XML file. Note that the white space (spaces, tabs, and new lines)
is stripped from the beginning and end of the values.

<config>

<param name="cl i ent1.location">/var/lib/jenkins/workspace/rice-2.2-rel ease-sitedeploy/src/test/clients/
Test d i ent 1</ par an>

<param name="cl i ent 2.1 ocati on">/var/lib/jenkins/workspace/rice-2.2-rel ease-sitedeploy/src/test/clients/
Test d i ent 2</ par an>

<par am nane="ksb. cl i ent 1. port">9913</ par an>

<par am nane="ksb. cl i ent 2. port">9914</ par an>

<par am name="ksb. t est har ness. port">9915</ par an»>

<par am nane="t hr eadPool . si ze" >1</ par an>

<par am nanme="t hr eadPool . f et chFr equency" >3000</ par an>

<par am nane="bus. r ef resh. r at " >3000</ par an>

<par am name="keystore. al i as">ri ce</ par an»>

<par am name="keyst or e. passwor d" >super - secr et - pw</ par an»>

<par am nane="keystore.file">/var/lib/jenkins/workspace/rice-2.2-rel ease-sitedepl oy/src/test/resources/
keyst or e</ par an>
</ config>

Here is an example of the Java code required to parse the configuration XML file and convert it into a
Properties object:

Config config = new Sinpl eConfig(configLocations, properties);
config. parseConfig();

In the sample above, configLocations is a List<String> containing file locations using the standard
Spring naming formats (examples: file:/whatever and classpath:/whatever). The variable propertiesisa
Properties object containing the default property values.

Here is an example of retrieving a property value from Java code:

String val = ConfigContext.getCurrent ContextConfig().getProperty(“keystore.alias”);
Aggregating Multiple Files

The Rice Configuration System has a specia parameter, config.location, which you use to incorporate
the contents of ancther file. Typically, you use this to include parameters that are maintained by system
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administratorsin secure locations. The parametersin the included file are parsed asif they had been in the
original file at that place. Here is an example:

<config>
<param nane="config.location">file:/nmy_secure_dir/ny_secure_file.xm </ paran>
</ config>

Building Parameter Values from Other Parameters

Once you have defined a parameter, you can use it in the definition of another parameter. For example:

<confi g>

<par am nanme="appl e">red del i ci ous</ paran»>

<par am nanme="t ast e" >yummy yumy</ par an»

<par am nane="appl e. t ast e" >${ appl e} ${tast e} </ paranr
</ config>

When this example is parsed, the value of the parameter apple.taste will be set to red delicious yummy
yummy.

Using the Parameters in Spring

Because the parameters are converted into a Properties object, you can retrieve the complete list of
parameters using this code:

config. getProperties()

You typically use this in Spring to parse a configuration and put its properties in a
PropertyPlaceHolderConfigurer so that the parameters are available in the Spring configuration file:

<bean id="config" class="org.kuali.rice.core.config.spring.ConfigFactoryBean">
<property name="configLocations">
<list>
<val ue>cl asspat h: ny- confi g. xm </ val ue>
</list>
</ property>
</ bean>

<bean i d="confi gProperties"
cl ass="org. springframework. beans. factory. confi g. Met hodl nvoki ngFact or yBean" >
<property name="target Gbj ect" ref="config" />
<property name="t ar get Met hod" val ue="get Properties" />
</ bean>

<bean cl ass="org. spri ngframework. beans. factory. confi g. PropertyPl acehol der Confi gurer">
<property name="properties" ref="configProperties" />
</ bean>

Once this is complete, the configuration parameters can be used like standard Spring tokens in the bean
configurations:

<bean i d="dat aSource" class="org. kuali.rice.core. database. XAPool Dat aSour ce" >
<property name="transacti onManager" ref="jotnt />
<property name="driverCl assNane" val ue="${dat asource. driver.nane}" />
<property name="url" val ue="${datasource.url}" />
<property name="naxSi ze" val ue="${dat asource. pool . mexSi ze}" />
<property name="ni nSi ze" val ue="${dat asource. pool . n nSi ze}" />
<property name="nmaxWit" val ue="${dat asource. pool . max\Wai t}" />
<property nanme="validationQuery" val ue="${datasource. pool . validati onQuery}" />
<property nanme="usernane" val ue="${dat asource. usernane}" />
<property nanme="password" val ue="${dat asource. password}" />

</ bean>

Initializing the Configuration Context in Rice

The Config object can beinjected into the RiceConfigurer that’s configured in Spring and it will initialize
the configuration context with those configuration parameters.

19



Global

Thisis done asfollows:
<bean id="config" class="org. kuali.rice.core.config.spring.ConfigFactoryBean">
</ bean>
<bean id="rice" class="org.kuali.rice.core.config.Ri ceConfigurer">

<property nanme="root Config” ref="config”/>
</ bean>

Overriding Configuration Values

The primary purpose of overriding configuration values is to provide a set of default values in a base
configuration file and then provide a separate file that overrides the values that need to be changed. You
can also update a parameter value multiple times in the same file. Parameter values can be changed any
number of times; the last value encountered while parsing the file will be the value that is retained.

For example, when parsing the file:

<confi g>
<par am nanme="t ast e" >yummy yummy</ par an>
<par am name="t ast e" >good st uf f </ par an>
</ config>

Thefina value of the parameter taste will be good stuff since that was the last value listed in thefile.

As another example, when parsing the file:

<confi g>
<par am name="t ast e" >yummy yummy</ par an>
<par am nanme="appl e. t ast e" >appl e ${taste} </ paran>
<par am name="t ast e" >good st uf f </ par an>

</ config>

The final value of the parameter apple.taste will be apple yummy yummy. This demonstrates that
parameters that appear in the value are replaced by the current value of the parameter at that point in the
configuration file.

Additionally, you can define certain parameters in such that they won’t override an existing parameter
vaueif it'salready set.

As an example of this, consider the following configuration file:

<confi g>
<param name="t aste" override="fal se”>even yunmm er </ par ans>
<par am narme="br and. new. paranf overri de="fal se”>brand new val ue</ par an»

</ config>

If this file was loaded into a configuration context that had already parsed our previous example, then
it would notice that the taste parameter has aready been set. Since override is set to false, it would
not override that value with even yummier. However, since brand.new.param had not been defined
previously, it's value would be set.

Data Source and JTA Configuration

The Kuali Rice software require aJava Transaction APl (JTA) environment in which to execute database
transactions. Thisallowsfor creation and coordination of transactionsthat span multiple data sources. This
feature is something that would typically be found in a J2EE application container. However, Kuali Rice
is designed in such a way that it should not require a full J2EE container. Therefore, when not running
the client or web application inside of an application server that provides a JTA implementation, you
must provide one. The default JTA environment that Kuali Rice uses is JOTM. There are other open-
source optionsavailable, such as Atomikos TransactionsEssentials, and there are al so commercial and open
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source JTA implementationsthat come as part of an application server (i.e. JBoss, WebSphere, GlassFish).
Alternatively, Kuali Rice can be configured to use Bitronix.

If installing Rice using the standalone server option and afull Java application server is not being utilized,
then the libraries required for JTA will need to be moved to the serviet server which is being used.
These libraries have aready been retrieved by Maven during project set up; it is a simple matter of
moving them from the Maven repository to the libraries directory of the servlet server. Assuming, for
instance, that Tomcat is being used, the following files need to be copied from the Maven repository to
$TOMCAT_HOME/common/lib:

« {Maven repository home}/repository/javax/transaction/jta/1.0.1B/jta-1.0.1B.jar

« {Maven repository home}/repository/jotm/jotm/2.0.10/jotm-2.0.10.jar

» {Maven repository home}/repository/jotm/jotm_jrmp_stubs/2.0.10/jotm_jrmp_stubs-1.0.10.jar
» {Maven repository home}/r epositor y/xapool/xapool/1.5.0-patch3/xapool-1.5.0-patch3.jar

» {Maven repository home}/repository/howl/howl-logger/0.1.11/howl-logger-0.1.11.jar

« {Maven repository home}/repository/javax/r esour ce/connector -api/1.5/connector -api-1.5.jar

» {Maven repository home}/repository/javax/r esour ce/connector/1.0/connector-1.0.jar

» {Maven repository home}/r epositor y/or g/obj ectweb/car ol/car ol/2.0.5/car ol-2.0.5.j ar

Additionally, the{Rice pr oj ect home}config/jotm/car ol.pr oper ties configuration file needs to be moved
to STOMCAT_HOME/common/classes, this time from the built Rice project.

Configuring JOTM

Configurethe JOTM transaction manager and user transaction objectsas Spring beansin your application’s
Spring configuration file. Here is an example:

<bean i d="transacti onManager XAPool " cl ass="org. spri ngfranewor k. transacti on. j t a. Jot nfFact or yBean" >
<property name="defaul t Ti meout" val ue="3600"/>
</ bean>

<al i as nanme="transacti onManager XAPool " al i as="j taTransacti onManager"/ >
<al i as nanme="transacti onManager XAPool " al i as="j t aUser Transaction"/>

Y ou can use these beansin the configuration of Spring’sJTA transaction manager and the Rice configurer.
This configuration might look like the following:

<bean i d="springTransacti onManager" class="org.springfranework.transaction.jta.JtaTransacti onManager">
<property name="user Transaction">
<ref | ocal ="userTransaction" />
</ property>
<property name="transacti onManager">
<ref |ocal ="jtaTransacti onManager" />
</ property>
</ bean>

<bean id="rice" class="org.kuali.rice.core.config.RiceConfigurer">
<property name="transacti onManager" ref="jtaTransacti onManager" />
<property name="user Transaction" ref="jtaUserTransaction" />

</ bean>

Configuring JOTM Transactional Data Sources

JTA requires that the datasources that are used implement the XADataSource interface. Some
database vendors, such as Oracle, have pure XA implementations of their datasources. However,
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internaly to Rice, we use wrappers on plain datasources using a library called XAPool. When
configuring transactional data sources that will be used within JOTM transactions, you should use the
org.kuali.rice.core.database.X APool DataSource class provided with Rice. Hereis an example of a Spring
configuration using this data source implementation:

<bean i d="nyDat aSource" cl ass="org. kuali.rice.core. database. XAPool Dat aSour ce" >
<property name="transacti onManager" ref="jtaTransacti onManager" />
<property name="driverC assNane" val ue="${dat asource.driver.nane}" />
<property name="url" val ue="${datasource.url}" />
<property name="nmaxSi ze" val ue="${datasource. pool . maxSi ze}" />
<property name="m nSi ze" val ue="${datasource. pool . m nSi ze}" />
<property name="nmaxWit" val ue="${datasource. pool . max\Vait}" />
<property name="val i dati onQuery" val ue="${dat asource. pool . val i dati onQuery}" />
<property name="usernane" val ue="${dat asource. usernane}" />
<property name="password" val ue="${dat asource. password}" />

</ bean>

Configuring JTOM Non-Transactional Data Sources

When using the built-in instance of the Quartz scheduler that Rice creates, you will need to inject a non-
transactional data source into the RiceConfigurer in addition to the JTA transactional instance. This is
to prevent deadlocks in the database and is required by the Quartz software (the Quartz web site has
an FAQ entry with more details on the problem). Here is an example of a non-transactional data source
configuration:

<bean i d="nonTransact i onal Dat aSour ce"
cl ass="or g. apache. commons. dbcp. Basi cDat aSour ce" destroy-net hod="cl ose" >
<property name="driverd assNanme" val ue="${dat asource. driver. nane}"/>
<property name="url" val ue="${datasource.url}"/>
<property name="maxActive" val ue="${dat asource. pool . maxActive}"/>
<property name="ninldle" value="7"/>
<property name="initial Size" value="7"/>
<property name="val i dationQuery" val ue="${dat asource. pool . val i dati onQuery}"/>
<property name="usernane" val ue="${dat asource. usernane}" />
<property name="password" val ue="${dat asour ce. password}" />
<property name="accessToUnder|yi ngConnecti onAl | owed"
val ue="${ dat asour ce. dbcp. accessToUnder | yi ngConnecti onAl | owed}"/ >
</ bean>

Y ou need to either inject this non-transactional data source into the Quartz SchedulerFactory Spring bean
(if you are explicitly defining it) or into the rice bean in the Spring Beans config file as follows:
<bean id="rice" class="org.kuali.rice.config.RiceConfigurer">
<pr operty name="nonTransacti onal Dat aSour ce" ref="nonTransacti onal Dat aSource" />
</ beéﬁ;
Configuring Bitronix

Configure the Bitronix transaction manager and user transaction objects as Spring beans in your
application’s Spring configuration file. Here is an example:

<bean i d="btmConfi g" factory-method="get Confi guration"”

cl ass="bi troni x.tm Transacti onManager Servi ces" |azy-init="true"/>
<bean i d="transacti onManagerBi troni x" cl ass="bi troni x.tm Transacti onManager Servi ces"

factory-net hod="get Tr ansact i onManager" depends-on="bt nConfi g" destroy-net hod="shut down" | azy-
init="true"/>

<al i as name="transacti onManagerBi troni x" alias="jtaTransacti onManager"/>
<al i as name="transacti onManager Bi troni x" alias="jtaUser Transaction"/>

You can use these beans in the configuration of the Rice configurer. This configuration might look like
the following:
<bean id="rice" class="org.kuali.rice.core.config.Ri ceConfigurer">

<property name="transacti onManager" ref="jtaTransacti onManager" />
<property name="user Transaction" ref="jtaUserTransaction" />
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</ bean>

Configuring Bitronix Transactional Data Sources

An example configuration of Btironix Transactional Data Sources.

<bean i d="ri ceDat aSourceBitroni xXa" class="bitronix.tmresource.]jdbc. PoolingDataSource" init-method="init"
destroy- et hod="cl ose" lazy-init="true">
<property name="cl assName" val ue="oracl e.j dbc. xa. cl i ent. Oracl eXADat aSour ce" />
<property name="uni queNanme" ref="ds-randomstring" />
<property name="m nPool Si ze" val ue="${dat asource. pool . nmi nSi ze}" />
<property name="nmaxPool Si ze" val ue="${dat asource. pool . naxSi ze}" />
<property name="useTmJoi n" val ue="true" />
<property name="testQuery" val ue="${datasource. pool . validati onQuery}" />
<property name="al | owLocal Transacti ons" val ue="true" />
<property name="driverProperties">
<pr ops>
<prop key="URL">${dat asource. url}</prop>
<prop key="user">${datasource. user nane} </ pr op>
<prop key="passwor d">${dat asour ce. passwor d} </ pr op>
</ props>
</ property>
</ bean>

<bean i d="ds-randomstring" class="org.springframework. beans. factory. config. Met hodl nvoki ngFact or yBean" >
<property name="stati cMet hod" val ue="org. apache. comons. | ang. Randonstri ngltil s. randomAl phanureric"/>
<property name="ar gument s"><| i st ><val ue>20</ val ue></1i st ></ property>

</ bean>

Configuring Bitronix Non-Transactional Data Sources

Notice the addition of the driverClassName prop in the dirverPropertiesin the non-transaction data source
configuration

<bean i d="ri ceDat aSourceBitroni x" class="bitroni x.tmresource.jdbc. PoolingDataSource" init-method="init"
destroy-nmet hod="cl ose" lazy-init="true">
<property name="cl assName" val ue="bitroni x.tmresource.jdbc.|rc.LrcXADataSource" />
<property name="uni queNanme" ref="ds-random string" />
<property name="ni nPool Si ze" val ue="${dat asource. pool . m nSi ze}" />
<property name="nmaxPool Si ze" val ue="${dat asource. pool . maxSi ze}" />
<property name="useTmJoi n" val ue="true" />
<property name="testQuery" val ue="${dat asource. pool . val i dati onQuery}" />
<property name="al | owLocal Transacti ons" val ue="true" />
<property name="driverProperties">
<props>
<prop key="Url">${datasource. url}</prop>
<prop key="driverd assNanme">${ dat asour ce. dri ver. nane} </ prop>
<prop key="user">${dat asour ce. user nane} </ pr op>
<prop key="password">${dat asour ce. passwor d} </ pr op>
</ props>
</ property>
</ bean>

<bean i d="ds-random string" class="org.springframework. beans. factory. confi g. Met hodl nvoki ngFact or yBean" >
<property name="staticMethod" val ue="org. apache. comons. | ang. RandonStringUtils. randomAl phanuneric"/>
<property nanme="argunents"><list><val ue>20</val ue></Ii st></property>

</ bean>

Version Compatibility

Commitment to Compatibility in Kuali Rice

Fromversion 2.0 of Kuali Riceupto at least version 3.0, the project iscommitted to providing what it refers
to as "middleware" or "client-server" service compatibility. This essentially means that an application
which isaclient of the Kuali Rice Standalone Server (either it's services or it's database) should be able
to continue to function properly even if the Rice Standal one Server or it's database is upgraded to a newer
version.
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More information on the scope of version compatibility in Kuali Rice can be found in the Kuali Rice
Version Compatibility Statement.

Keeping Your Client Application Compatible

There are afew rulesthat a client application using the Kuali Rice apis must following in order to ensure
the client application remains compatible once the Kuali Rice Standalone Server is updated. These rules
only apply in situations where there is a standalone instance of Kuali Rice which is being integrated with.
In the case that an application is running Kuali Rice "bundled”, then compatibility is not a concern since
that application forms a single software bundle with Kuali Rice included.

First, client-server compatibility only pertains to the components of Rice which have client-server
interaction, that includes the following components and their sub-modules:

» Core Service
+ KSB

« KEW

* KIM
 KEN

« KRMS

* Location

There are some components of Rice which are "framework-only” and don't contain any client-server
remoting components. These include:

» Core
« KNS
« KRAD

Thereare, additionally, some modul es of Ricewhich only run aspart of the standal one server (or in bundled
mode) and those include eDocL ite and the various "web" modules of Rice.

Only the first set of "client-server" Rice components are presently under the constraints of version
compatibility.

A summary of the rules a client application needs to follow in order to ensure they remain version
compatible is as follows:

« If integrated with astandlone Kuali Rice server, do not configure any of the Kuali Rice componentswith
arun mode of LOCAL. The LOCAL run modeisonly for afully bundled configuration of Kuali Riceasit
interactsdirectly with al of the Kuali Rice database tablesinstead of using remotely accessible services.

* In application code, only use classes in the api or framework modules of the "client-server”
components. This should be evident from the package names for the module as they should
have "api" or "framework” in the package name (i.e. org. kuali.rice. kew. api .* and
org. kuali.rice.kimframework. *).

» Do not write custom code which interacts directly with the Kuali Rice database tables which are part of
any of the previously mentioned "client-server" components.
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» When writing code against the Rice apis or frameworks, be sure to read the javadocs and be sure to
conform to the contracts specified therein.

* When implementing “callback"  services, ensure that you ae using the
Cal | backSer vi ceExporter properly as  specified in the section called
“ CallbackServiceExporter”
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Chapter 2. KEN

KEN Overview
What is KEN?

Kuali Enterprise Notification is a form of communication between distributed systems that allows
messages to be sent securely and consistently. These messages act as notifications upon receipt and are
processed asynchronously within the service layer. The following architectural diagram represents the
flow of messagesin atypical Rice Environment.

Figure2.1. KEN Message Flow
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From a developer’s perspective the diagram below helps to represent the inner workings of how KEN
stores data from the Data Modeling Layer into the Persistence Layer.
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Figure 2.2. KEN Message Storage
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The following sections of documentation aim at describing the inner workings of KEN as well as how
those pieces interact with Rice, specificaly KEW. KEN itself is an interface that sits on top of KEW’s
API. Thisallowsfor registration and publishing of notifications, which then flow through KEW toresultin
aKEW action request. See KEW Overview for more information. In addition to the action list, KEW can
be optionally configured to forward these requests to the Kuali Communications Broker or KCB for short.
Thismoduleislogically related to KEN and handles dispatching messages based on the user preferences.
Once messages are dispatched, aresponse or acknowledgement can be created.

KEN Configuration Parameters

Table2.1. KEN Core Parameters

Configuration Parameter Description Default value

ken.url The base URL of the KEN webapp; this should be | ${ application.url} /ken
changed when deploying for external access

notification.resolveM essageDeliveriesJob.startDelayM S The start delay (in ms) of the job that resolves message | 5000
deliveries

notification.resolveM essageDeliveriesJob.intervaM S The interval (in ms) between runs of the message| 10000

delivery resolution job
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Configuration Parameter Description Default value
notification.processAutoRemoval Job.startDelayM S The start delay (in ms) of the job that auto-removes| 60000
messages
notification.processAutoRemoval Job.intervaM S Theinterval (in ms) between runs of the message auto- | 60000
removal job
notification.quartz.autostartup Whether to automatically start the KEN Quartz jobs | true
notification.concurrent.jobs Whether the invocation of a KEN Quartz job can|true
overlap another KEN Quartz job running concurrently
ken.system.user The principal name of the user that KEN should use| notsys

when initiating KEN-originated documents

keb.url

The base URL of the KCB (notification broker)
webapp

$ application.url} /kch

keb.messaging.synchronous Whether notification messages are processed |false
synchronously
kch.messageprocessing.startDelayM S The start delay (in ms) of the job that processes| 50000
notification messages
kcb.messageprocessing.repeatintervaM S The interva (in ms) between runs of the notification | 30000
message processing job
keb.quartz.group Group name of the KCB Quartz job KCB-Délivery
keb.quartz.job.name Name of the KCB Quartz job M essageProcessingJobDetail
keh.maxProcessAttempts Maximum number of times that KCB will attempt to| 3
process a notification message
notification.processUndeliveredJob.intervalM S The elapsed time, in milliseconds, between runs of the | 20000
KEN process undelivered notifications job.
notification.processUndeliveredJob.startDelayM S The elapsed time, in milliseconds, between the start of | 10000

Note

the application and the first run of the KEN process
undelivered notifications job.

Asof Rice 1.0.1, The parameter kcb.smtp.host is no longer used. The smtp server settings that
are required for sending email notifications with KEN are documented in the Kuali Enterprise
Workflow (KEW) Technical Reference Guide under Email Configuration.

KEN Channels

A KEN Channél is correlated to a specific type of notification. An example of a Channel’ s use may be to
send out information about upcoming Library Events or broadcast general announcements on upcoming
concerts. Channelsare subscribed to in the act of receiving notificationsfrom apublisher or producer. They
can al so be unsubscribed to and removed from the data store from within the Ul. The Channel Definitions

are stored in the database table KREN_CHNL _T. The columns are listed as follows:

Table2.2. KREN_CHNL_T

Column Description

CHNL_ID Identifier for the Channel

NM Name of the Channel represented in the Ul

DESC_TXT Description of the Channel

SUBSCRB_IND Determines if the Channel can or cannot be subscribed to from the Ul. This also determinesiif the
channel will be displayed in the Ul

VER_NBR Version Number for the Channel
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Channel Subscription

Channels can be subscribed to through the Ul and also through the direct access to the data store. To

add a channel that can be subscribed to simply run the following SQL statement against the data store
customizing value entries to your needs:

I NSERT | NTO KREN_CHNL_T ( CHNL_I D, DESC_TXT, NM SUBSCRB_| ND, VER_NBR)

VALUES (2,' This channel is used for sending out information about Library Events.','Library Events
Channel ', "Y',

1)

KEN Producers

A KEN Producer submitsnotificationsfor processing through the system. An example of aProducer would
be a mailing daemon that represents messages sent from a University Library System.

Characteristics of a Producer:
 Producers create and send notifications to a specific destination through various Channels.
 Each Producer contains alist of Channelsthat it may send notifications to.

» Producer Definitions are stored in the database table KREN_PRODCR _T.

Table2.3. KREN_PRODCR_T

Column Description

CNTCT_INFO The email address identifying the Producer of the Notification.

DESC_TXT A Description of the Producer.

NM Name of the Producer.

PRODCR_ID The Producer’s Channel Identifier. Seethe KREN_CHNL_PRODCR_T tablefound in the database
for more information on how Producers link to Channels.

VER_NBR Version Number for the Producer.

Adding Producers

The Producer can be added through direct access to the data store. To add a Producer run the following
SQL statement against the data store customizing val ue entries to your needs:

I NSERT | NTO KREN_PRODCR T ( CNTCT_| NFO, DESC_TXT, NM PRCDCR _| D, VER_NBR)

VALUES (' kual i -ken-testing@ornell.edu','This producer represents nessages sent fromthe general nessage
sending fornms.'," Notification Systeni,1,1)

KEN Content Types

Overview

A Content Type is part of the message content of a notification that may be sent using KEN. It can be as
simple as a single message string, or something more complex, such as an event that might have a date
associated with it, start and stop times, and other metadata you may want to associate with the notification.

KEN isdistributed with two Content Types: Simple and Event.
Warning

It is strongly recommended that you |eave these two Content Types intact, but you can use them
as templates for creating new Content Types.
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Every notification sent through KEN must be associated with aregister ed Content Type. Registration of
Content Types requires administrative access to the system and is described in the KEN Content Types
section in the User Guide. The rest of this section describes the Content Type attributes that are required
for registration.

Content Type Attributes

A Content Type is represented as a NotificationContent business object and consists of several attributes,
described below:

id - Uniqueidentifier that KEN automatically creates when you add a Content Type

name - Thisis a unique string that identifies the content. For example, ItemOverdue might be the name
used for a notification Content Type about an item checked out from the campus library.

description - Thisisamore verbose description of the Content Type. For example, "Library item overdue
notices' might be the description for ItemOverdue.

namespace - This is the string used in the XSD schema and XML to provide validation of the content,
for example, notification/ContentTypeltemOverdue. The XSD namespace is typically the name attribute
concatenated to the notification/ContentType string. Note how it is used in the XSD and XSL examples
below.

xsd - The XSD attribute contains the complete W3C XML Schema compliant code.

<?xm version="1.0" encodi ng="UTF-8"?>
<!-- This schema defines a generic event notification type in order for it to be accepted into the system -->
<schema xm ns="http://wwmv. w3. or g/ 2001/ XM_Schena"
xm ns: c="ns: notification/ comon"
xm ns: ce="ns: notification/ Content Typel t enOver due”
tar get Namespace="ns: noti fi cati on/ Cont ent Typel t enOver due"
attributeFornDef aul t ="unqualified"
el enent For nDef aul t ="qual i fi ed">
<annot at i on>
<docurnent ati on xnl: | ang="en">Item Overdue Schema</docunentati on>
</ annot at i on>
<i nport namespace="ns:notification/compn" schemaLocati on="resource: notification/notification-comon" />

<!-- The content el enent describes the content of the notification. It contains a nessage (a sinple
String) and a nessage el enent -->
<el enent nane="content">
<conpl exType>

<sequence>
<el ement name="nessage" type="c:LongStringType"/>
<el enent ref="ce:event"/>

</ sequence>

</ conpl exType>
</ el ement >

<!-- This is the itenpverdue elenent. It describes an item overdue notice containing a summary,
description, location, due date, and the ambunt of the fine levied -->
<el enent nane="itenoverdue">
<conpl exType>

<sequence>
<el ement name="summary" type="c: NonEnptyShort StringType" />
<el ement name="description" type="c: NonEnptyShortStringType" />
<el ement name="| ocation" type="c: NonEnptyShortStringType" />
<el ement name="dueDat e" type="dateTime" />
<el enent name="fine" type="deciml" />

</ sequence>

</ conpl exType>
</ el ement >

</ schema>

xd - The XSD attribute contains the complete XSL code that will be used to transform a notification in
XML to html for rendering in an Action List.

<?xm version="1.0" encodi ng="UTF-8"?>
<l-- style sheet declaration: be very careful editing the follow ng, the
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def aul t nanmespace nust be used otherw se elenents will not match -->
<xsl : styl esheet

versi on="1. 0"

xm ns: xsl ="http://ww. w3. org/ 1999/ XSL/ Tr ansf or nt

xm ns: n="ns: notification/Content TypeEvent"

xm ns: xsi ="http://ww. w3. org/ 2001/ XM_Schera- i nst ance"

xsi : schemaLocati on="ns: notifi cati on/ Content Typel t emOver due resource: notification/ Content Typel t emOver due”
excl ude-resul t-prefixes="n xsi">

<!-- output an htm fragment -->
<xsl| :output method="htm" indent="yes" />

<!-- match everything -->
<xsl:tenpl ate match="/n:content" >
<tabl e class="bord-all">
<xsl| :apply-tenplates />
</tabl e>
</ xsl : tenpl at e>

<l-- match nmessage el ement in the default namespace and render as strong -->
<xsl:tenpl ate match="n: message" >
<capti on>
<strong><xsl : val ue- of select="." disabl e-out put-escapi ng="yes"/></strong>

</ capti on>
</ xsl : tenpl at e>

<!-- match on itenoverdue in the default namespace and display all children -->
<xsl :tenpl ate match="n:itenoverdue">
<tr>

<td class="thnormal "><strong>Summary: </strong></td>
<td class="thnormal "><xsl : val ue- of sel ect="n:summary" /></td>
</tr>
<tr>
<td class="thnormal "><strong>ltem Description: </strong></td>
<td class="thnormal "><xsl : val ue- of sel ect="n:description" /></td>
</tr>
<tr>
<td class="thnormal "><strong>Li brary: </strong></td>
<td class="thnormal "><xsl : val ue- of select="n:location" /></td>
</tr>
<tr>
<td class="thnormal "><strong>Due Date: </strong></td>
<td class="thnornmal "><xsl : val ue-of select="n:startDateTi ne" /></td>
</tr>
<tr>
<td class="thnornal "><strong>Fi ne: </strong></td>
<td class="thnormal ">$<xsl : val ue-of select="n:fine" /></td>
</tr>
</ xsl : tenpl at e>
</ xsl : styl esheet >

KEN Notifications

This document provides information about the attributes of a Notification. These attributes are elements
such as message content, who is sending the notification, who should receive it, etc. Kuali Enterprise
Notification (KEN) supports an arbitrary number of Content Types, such as a simple message or an event
notification. Each Content Type consists of acommon set of attributes and a content attribute.

Common Notification Attributes

Table 2.4. Common Notification Attributes

Name | Type | Required | Description | Example

channel | string | yes * Name of achannel | Library Events
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Name Type Required | Description Example
* Must beregistered
producer string yes « Name of the producing system Library Calendar System
¢« Must be registered and given
authority to send messages on
behalf of the <Library Events>
channel
senders alist of strings yes A list of the names of people on|TestUserl, TestUser2
whose behalf the message is being
sent
recipients alist of strings yes A list of the names of groups or users| library-staff-group, TestUserl,
to whom the message is being sent | TestUser2
deliveryType string yes fyi or ack fyi
sendDateTime datetime no When to send the notification 2006-01-01 00:00:00.0
autoRemoveDateTime datetime no When to remove the notification 2006-01-02 00:00:00.0
priority string yes An arbitrary priority; these must be| normal
registered in KEN; the system comes
with defaults of normal, low, and
high
contentType string yes Name for the content; KEN comes|simple
set up with simple and event; new
contentTypes must be registered in
KEN
content see below yes The actual content see below

Message Content

Notifications are differentiated using the contentType attribute and the contents of the content element.
The content element can be as simple as a message string or it may be a complex structure. For example,
a simple natification may only contain a message string, whereas an Event Content Type might contain
a summary, description, location, and start and end dates and times. Examples of the Smple and Event
Content Types:

Sample XML for a Simple Notification

<?xm version="1.0" encodi ng="UTF-8"?>

<l-- A Sinmple Notification Message -->

<notification xm ns="ns:notification/NotificationRequest"
xm ns: xsi =htt p: // wwv. w3. or g/ 2001/ XM_Schema- i nst ance
xsi : schemalLocation="ns: notification/NotificationRequest
resource: notification/NotificationRequest">

<l-- this is the name of the notification channel -->
<!-- that has been registered in the system-->

<channel >Canpus Status Announcenent s</ channel >

<l-- this is the name of the producing system-->

<!-- the value nmust natch a registered producer -->

<pr oducer >Canpus Announcenents Systenx/producer>

<l-- these are the people that the nmessage is sent on -->
<!-- behalf of -->

<sender s>

<sender >John Fereira</sender>
</ sender s>

<l-- who is the notification going to? -->
<reci pi ent s>

<gr oup>Ever yone</ gr oup>

<user >j af 30</ user >
</ reci pi ent s>

<l-- fyi or acknow edge -->
<del i veryType>fyi </ del i veryType>
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<!-- optional date and time that a notification should be sent -->
<!-- use this for scheduling a single future notification to happen -->
<sendDat eTi me>2006- 01- 01T00: 00: 00</ sendDat eTi ne>

<l-- optional date and time that a notification should be renoved -->
<!-- fromall recipients' lists, b/c the message no |onger applies -->
<aut oRenpveDat eTi me>3000- 01- 01T00: 00: 00</ aut oRenpveDat eTi ne>

<l-- this is the name of the priority of the message -->
<l-- priorities are registered in the system so your value -->
<!-- here nust match one of the registered priorities -->

<priority>Normal </priority>

<title>School is Cosed</title>

<l-- this is the name of the content type for the nessage -->
<l-- content types are registered in the system so your value -->
<l-- here nust match one of the registered contents -->

<cont ent Type>Si npl e</ cont ent Type>

<l-- actual content of the message -->

<content xm ns="ns:notification/ContentTypeSi npl e"
xsi : schemaLocati on="ns: notifi cati on/ Content TypeSi npl e
resource: notification/ Content TypeSi npl e" >

<message>Snow Day! School is closed. </ message>
</ content >
</ notification>

Sample XML for an Event Notification

<?xm version="1.0" encodi ng="UTF-8"?>

<notification xm ns="ns:notification/Notificati onMessage"
xm ns: xsi ="http://ww. w3. org/ 2001/ XM_Schera- i nst ance"
xsi : schemaLocati on="ns: notification/NotificationMessage
resource: notification/Notificati onMessage">
<l-- this is the name of the notification channel -->
<!-- that has been registered in the system-->
<channel >Concerts Comi ng to Canpus</channel >

<l-- this is the name of the producing system-->
<!-- the value nust match a registered producer -->
<producer >Canpus Events O fi ce</producer>

<!-- these are the people that the nmessage is sent on -->
<!-- behal f of -->
<sender s>

<sender >ag266</ sender >
<sender >j af 30</ sender >
</ sender s>

<l-- who is the notification going to? -->
<r eci pi ent s>
<group>Group X</ group>
<group>G oup Z</ group>
<user >ag266</ user >
<user >j af 30</ user >
<user >ar h14</ user >
</ recipients>

<l-- fyi or acknow edge -->
<del i veryType>fyi </ del i veryType>
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<!-- optional date and time that a notification should be sent

<!-- use this for scheduling a single future notification to happen -->

<sendDat eTi me>2006- 01- 01 00: 00: 00. 0</ sendDat eTi me>

<!-- optional date and time that a notification should be renoved -->
<l-- fromall recipients' lists, b/c the message no |onger applies -->

<aut oRenpveDat eTi me>2007- 01- 01 00: 00: 00. 0</ aut oRenpveDat eTi me>

<l-- this is the name of the priority of the nmessage -->
<l-- priorities are registered in the system so your value -->
<!-- here nust match one of the registered priorities -->

<priority>Normal </priority>

<l-- this is the name of the content type for the nessage -->
<l-- content types are registered in the system so your value -->
<l-- here nust match one of the registered contents -->

<cont ent Type>Event </ cont ent Type>

<l-- actual content of the nmessage -->
<cont ent >
<message>CCC presents The Strokes at Cornel |l </ message>

<l-- an event that it happening on canmpus -->

<event xm ns="ns:notification/ContentEvent"
xsi : schemaLocati on="ns: notifi cati on/ Cont ent Event
resource: notification/ ContentEvent">
<summar y>CCC presents The Strokes at Cornel | </ summary>
<descri ption>bl ah bl ah bl ah</descri ption>
<l ocati on>Barton Hal |l </| ocati on>
<start Dat eTi me>2006- 01- 01T0O0: 00: 00</ st ar t Dat eTi me>
<st opDat eTi me>2007- 01- 01T00: 00: 00</ st opDat eTi ne>

</ event >

</ content >
</notification>

Notification Response

When KEN sends a notification, it always returns aresponse. Thisis an outlinein XML of that response:

<?xm version="1.0" encodi ng="UTF-8"?>
<r esponse>

<st atus>success</ st at us>
</ response>

Enterprise Notification Priority

Managing Priorities

There is no user interface page to manage priorities so you must make changes to the list of prioritiesin

thekren_prio_t table using SQL.

The table has these columns:

Table25. KREN_PRIO_ T

Name Type Max Size Required Attribute
PRIO_ID Numeric 8 Yes 1D

NM Text 40 Yes Name
DESC_TXT Text 500 Yes Description
PRIO_ORD Numeric 4 Yes Order
VER_NBR Numeric 8 Yes Version
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Example 2.1. Example— Thisisan example of how to add a Priority into thetable:

I NSERT | NTO kren_prio_t (PRIOID, NM DESC TXT, PR O ORD, VER NBR) VALUES (8, 'Bulk', 'Mass notifications', 6,

1);

KEN Delivery Types

This section describes Kuali Enterprise Notification (KEN) Delivery Types, or what are sometimes called
Message Deliverers. A Message Deliverer Plugin is the mechanism used to deliver a notification to end
users. All notifications sent through KEN appear in the Action List for each recipient for which the
notification is intended. This message aso contains an Email Delivery Type that allows you to send end
users a notification summary as an email message. Note that for a Delivery Type other than the default
(KEWActionList), the content of the notification is typically just a summary of the full notification.

Implementing the Java Interface

B T T T

*/

Creating a new Dédlivery Type primarily involves implementing a Java interface called
org.kuali.rice.kew.deliverer.NotificationM essageDeliver er. The source code of the interface:

Li censed under the Educational

Copyright 2007 The Kuali Foundat

ion

Communi ty License, Version 2.0 (the "License");
you may not use this file except in conpliance with the License.
You may obtain a copy of the License at

http://ww. opensource. org/ |l i censes/ ecl 2. php

Unl ess required by applicable |aw or agreed to in witing, software

di stributed under the License is distributed on an "AS | S" BASIS,

W THOUT WARRANTI ES OR CONDI TI ONS OF ANY KI ND, either express or inplied.
See the License for the specific |anguage governing perm ssions and
limtations under the License.

package org. kuali.rice.ken.deliverer;

i mport
i mport
i mport
i mport
i mport

i mport
i mport

| **

java.util.Hash

Map;

java. util.Li nkedHashMap;

org. kuali.rice
org. kuali.rice

org. kuali.rice
org. kuali.rice
org. kuali.rice

. ken.
. ken.

. ken.
. ken.
. ken.

bo. Noti fi
exception

exception
exception
exception

cati onMessageDel i very;
.ErrorlList;

. Notificati onAut oRenbveExcepti on;
.Notificati onMessageDel i ver yExcepti on;
.Notificati onMessageDi sm ssal Excepti on;

* This class represents the different types of Notification Delivery Types that the system can handle.
exanpl e, an instance of delivery type could be "ActionList" or "Email" or "SM5". Any deliverer
i npl emrent ati on
* adhering to this interface can be plugged into the systemand will be automatically avail able for use.

* For

* @ut hor Kual i

*/

Ri ce Team (kuali-rice@oogl egroups. com

public interface Notificati onMessageDeliverer {

| **

* This nmethod is responsible for delivering the passed in nmessageDelivery record.
* @ar am nessageDel i very The nessageDel ivery to process
* @hrows NotificationMessageDeliveryException

*/

public void deliverMessage(Notificati onMessageDel i very nessageDel i very) throws
Noti fi cati onMessageDel i ver yExcepti on;
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/**

* This method handl es auto renoving a nmessage delivery froma person's list of notifications.
* @aram nessageDel i very The nessageDel ivery to auto renove

* @hrows NotificationAut oRenbveException

*/

public void aut oRenbveMessageDel i very(Notificati onMessageDel i very nmessageDel i very) throws
Noti fi cati onAut oRenbveExcepti on;

/**
* This nmethod dism sses/renoves the NotificationMessageDelivery so that it is no |onger being presented to
the user
* via this deliverer. Note, whether this action is nmeaningful is dependent on the deliverer
inmplenmentation. |If the
* deliverer cannot control the presentation of the nessage, then this nethod need not do anything.
* @ar am nessageDel i very the nessageDel ivery to dismss
* @aramthe user that caused the dismssal; in the case of end-user actions, this will nost I|ikely be the
user to
* which the nessage was delivered (user recipient in the NotificationMessageDelivery object)
* @aram cause the reason the nessage was di sm ssed
*/

public void disnm ssMessageDel i very(Notificati onMessageDel i very messageDel i very, String user, String cause)
throws Notificati onMessageDi sm ssal Excepti on;

KEN: Sending a Notification

The Kuali Enterprise Notification system (KEN) provides for a way to programmatically send a
notification. An application may construct a notification using the KEN web service API.

Send a Notification Using the Web Service API

To send a noatification using the web service API, the notification must be constructed as an XML
document that validates agai nst aschemafor aspecific Content Type. For more detail, seethe Notifications
documentation.

To validate your notification XML, you must construct the XSD schema filename. To construct this file
name, append the Content Type value to ContentType.

For example, if you create anew Content Typefor alibrary book overdue notification, then the content Type
element value should be OverdueNotice and the schemafile you created for validation of the notification
XML should be ContentTypeOverdueNotice.xsd. This XML schema should be declared as a namespace
inthe content element of the notification XML. Out of the box, KEN comeswith Smple and Event Content
Types.

Web Service URL

By default, the Notification Web Service APl may be accessed at: http://yourlocalip:8080/natification/
services/Notification

A WSDL may be obtained using the following URL: http://yourlocalip:8080/notification/services/
Notification?2wsdl

Note

In the URL s above, replace yourlocalip with the hostname where KEN is deployed.

Exposed Web Services

Initially, KEN exposes a web service method to send a notification. The sendNotification method is a
simple String In/String Out method. It accepts one parameter (notificationMessageAsXml) and returns a
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notificationResponse as a String. For the format of the response, see the Notification Response document
inthe TRG for KEN.

Calling the sendNotification Service from JAVA

First, create a String that includes the XML content for the notification, as described in the Notification
Message document of the TRG for KEN. In the following example code, the XML representation
of the notification is read as a file from the file system in the main method, and the code calls the
MySendNotification method to invoke the Notification web service.

A SOAP style web services binding stub is available in the notification.jar file, as described above in
the Dependencies section.

Y ou may use this code as atemplate for sending a notification using the web service:

package edu.cornell.library.notification;

i mport org.apache.commons.io.lQUtils;
import org. kuali.notification.client.ws.stubs.NotificationWbServiceSoapBi ndi ngSt ub;

import java.io.|OException;

import java.io.lnputStream
import java.net.URL;

public class MyNotificati onWebServiced ient {
private final static String WEB_SERVICE URL = "http://]ocal host: 8080/ notification/services/Notification";

public static void MySendNotification(String notificati onMessageAsXnml) throws Exception {
URL url = new URL(WEB_SERVI CE_URL);
Noti fi cati onWebSer vi ceSoapBi ndi ngSt ub stub = new Notificati onWebServi ceSoapBi ndi ngStub(url, null);
String responseAsXm = stub.sendNotification(notificati onMessageAsXn);
/1 do sonething useful with the response
System out. println(responseAsXn);

}

public static void main(String[] args) {
I nput Stream noti ficati onXM. =
M/Not i fi cati onWebServi ced i ent. cl ass. get Resour ceAsSt rean("webservi ce_notification.xm");

String notificati onMessageAsXm = "";

try {
notificati onMessageAsXm = 1 QUtils.toString(notificationX\);

} catch (1 OException ioe) {
t hrow new Runti neException("Error |oadi ng webservice_notification.xm");

}

try {
MySendNot i fication(notificati onMessageAsXnl);

} catch (Exception ioe) {
t hrow new Runti neException("Error running webservice");

}
}

}

KEN Authentication
Web

KEN can support any Web Sign On technology that results in the population of the HttpServletRequest
remote user variable, exposed via the getRemoteUser accessor.

public java.lang.String getRemoteUser ()
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Returns the login of the user making this request, if the user has been authenticated, or null if the user
has not been authenticated. Whether the user name is sent with each subsequent request depends on the
browser and type of authentication.

Returns: A Sring specifying the login of the user making this request, or null

The generic KEN release comes configured with CAS.

Web Services

Web service authentication is part of the development process and is not implemented by the standalone
release of Rice. The notification web serviceis Axis-based.
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Chapter 3. KEW
What is Kuali Enterprise Workflow?

What

What

is workflow, in general?

Workflowisavery general term and means different thingsin different contexts. For example, it may mean
the sequence of approvals needed for a Leave Request or it may refer to a complex scientific procedure.

In our context of enterprise applications within a higher education institution, we're usually talking about
business process management when we discuss workflow. Usually, this revolves around business rules,
authorizations, and routing for approval.

A simple example is a leave request system. It needs some workflow to get the necessary people
(supervisor, etc.) to approveit. Thisis one example of the routing and approval side of aworkflow.

Y ou may also have business rules in workflow that dictate that some people get automatic approval for
leave requests. Thisis abusiness rule detail that workflow executes by automatically routing these types
of requests past the approval steps.

is Kuali Enterprise Workflow, in particular?

The Kuali Enterprise Workflow (KEW) product revolves around routing and approval of documents. It is
a stand-alone workflow engine upon which you can integrate other enterprise applications to do routing
and approvals.

In addition, KEW contains an eDocL ite system. This is a mechanism to create simple data-entry forms
directly in KEW. Y ou can also create routing rules around eDocL ite forms. eDocL ite forms are the rough
equivaent of the basic, one- or two-page forms that are commonly used to process business and get
signature approvals.

The benefit of eDocLite in KEW isthat it does not require a separate application. Y ou can use eDocL ite
in KEW simply by setting up the forms that your institution or department needs.

Overall, KEW is based on documents. In KEW, each document has a collection of transactions or things
to be done. Each transaction is approved or denied individually in KEW.

For example, John Doe may use a Leave Request document in KEW to ask for a week off in June. The
KEW Leave Request document contains enough information for his supervisor to make a decision about
John’sleave. (The document may use datakeysto retrieve external information, such as John’ spast Leave
Requests and available hours.) Once John submits his Leave Request, KEW routesit to John's supervisor
for approval. Depending on how John' s department has configured KEW for routing L eave Requests, after
John’s supervisor approves or denies his request, KEW may route it to more people for further action to
be taken.

Once John's Leave Request document is processed, it triggers a PostProcessor, which can peform any
desired additional processing. This is most commonly used to “finalize” the business transaction once
all approvers have signed off on it. In this particular example, it might call another service that would
update recordsin the L eave Request application’ s database, indicating that the individual has successfully
scheduled leave during that time period.

In addition, the KEW PostProcessor contains hooks for all the stages that a document goes through. For
example, an external application may use a KEW workflow for routing and approval of documents, and
that application may take action at each change in state of a routed document.
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What

What

problems or functions does KEW solve?

The primary benefit of KEW workflow is the correct routing for approval of documents. It enforces your
business-specific rules about who needs to approve what documents, in which scenarios.

Simple Workflow Example

Leave Request: Each person has one other person (possibly more) who needs to approve his or her leave
requests. Inthiscontext, KEW isthe system that managesboth the approval structure and theleaverequests
themselves (the actual approvals).

More Complex Workflow Example

Purchasing Desktop Computers: Y ou may need several business rulesin KEW for this, such asarule to
enforce:

1. A strategic alliance requires that you buy from one vendor unless there is ajustification to not do so

2. Genera purchasing approval by the Purchasing Department is required when the cost of the purchase
exceeds a certain limit

3. Approva by the account owners who fund the purchase is required
In this example, KEW requires an approval if:

e Thestrategic alliance is not used

» Thecost limit for Purchasing Department approval is exceeded

The workflow also requires an approval by the signer (or delegate) for each spending account that you
use for the purchase.

In KEW, Approval Types are set up such as account approver, supervisor, or organizational/department
hierarchy approver. An Approval Type containsthe applicable routing and approval rules. Onceyou create
an approval type, those routing and approval rules are available for other workflow clients and scenarios.
This creates a tipping point situation, in which the more applications and business processes you set up
through workflow, the easier it gets to do new ones.

In addition, KEW can help you with distributed management of approval structures. Each group at your
institution (each college, unit, division, etc.) can create their own approval and workflow structure for their
group, and you can centrally manage the workflow above those groups. This allows groups to manage
their own internal controls and structures, while still being subject to higher-level institutional controls.

problems does KEW NOT solve?

KEW is not a general-purpose application builder. For complex applications, you need to develop
applications separately and then integrate them with KEW. For simple forms or documents that need
approval, you can useeDocL ite, but thisonly worksin simple cases, analogousto aone- or two-page paper
form that requires signatures. It isimportant to note, however, that Kuali Rice does include a framework
called the Kuali Nervous System (KNS) that can be used to facilitate the development of more complex
applications and includes built-in integration with KEW.

KEW is not a general-purpose business rules engine. For example, it does not know that a continuation
account must be specified when an account is closed. Those types of rules are the responsibility of the
application itself to manage. However, this is not a clear-cut line, as KEW does manage business rules
that directly affect routing and approval.
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KEW is not an Organization Hierarchy manager. For example, it will not automatically manage your
organizational hierarchies and internal structures. However, integration with these hierarchies and
structures can be accomplished using KEW, and leveraging such hierarchies for routing and approval is
avery common need for many applications.

With which applications can KEW integrate?

Can |

Nearly anything, in theory. In the current version of KEW, any application can access KEW if it can:
» Do Javamethod calls, or

+ Do remote method invocation, or

» Do web-servicescalls, or

» Communicate with the Kuali Service Bus (KSB)

(The recommended cross-platform integration method is over web services.)

use KEW without building an entire application?

Y es, absolutely!

KEW isanincredibly powerful platform for routing and approval for enterprise (i.e., large) applications.
However, it also includes eDoclL ite, which makes it easy to develop simple business-process forms and
run them through KEW. In this situation, in its most simple form, you can do al of your work within
KEW, and most of that work isin developing your form configurations. If needed, the eDocL ite process
can also hook into a post-processor to take an action once a document's approvals are compl ete.

Steps to Building a KEW Application

Preface

Initssimplest form, KEW is merely a set of services that can be used to submit documents to aworkflow
engine and then interact with those documents as the progress through the routing process. Therefore,
there are many different ways to build an application that uses KEW. Kuali Rice itself has afew built-in
solutions (eDocLite and KNS) that make it easier to build applications that use KEW. Alternatively, an
application can be built from scratch or retrofitted to use KEW.

In this section, we will look at some common approaches to designing and building an application which
leverages KEW. However, it is by no means exhaustive and is simply meant to get you started and give
you ideas as you embark upon devel opment of your own applications that use Kuali Enterprise Workflow.

Initial Steps - Determine the Routing Rules

Determine to whom you want to route the document and when it should be routed. For example, in the
Travel Request Sample Workflow Client Application, the steps in the routing process are:

1. Someone submits atravel request for atraveler

2. Traveler receives an Approve Action Item

3. Traveler's supervisor receives Approve Action Item

4. Traveler's dean/director receives Acknowledge Action Item

5. Fiscal Officer for account(s) receives Approve Action Item
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Configure the Process Definition

In KEW, process definitions are attached to Document Types. The Document Type alows for
configuration of various pieces of the business process in addition to the process definition.

The Document Type is defined in XML format. KEW can ingest files containing this Document
Type configuration to set up the specified workflows and then executes the workflows based on that
configuration.

Oneexampleof routing configurationisthe Travel Reguest application. The Document Type configuration

is defined in the following four XML files:

TravelRoutingConfiguration.xml - Defines the travelDocument Document Type,
PostProcessor, docHandler, and routeNodes:

<?xm version="1.0" encodi ng="UTF-8"?>

<data xm ns="ns: workfl ow' xml ns:xsi="http://ww.w3. org/ 2001/ XM_Schema- i nst ance" xsi:schemaLocati on="ns: wor kf| ow

resour ce: Wr kf | owDat a" >
<docurnent Types xml ns="ns: wor kf | ow Docunent Type" xsi:schenmalLocati on="ns: wor kf | ow Docunent Type
resour ce: Docunent Type" >
<docunent Type>
<nanme>Tr avel Request </ nanme>
<description>Create a New Travel Request</description>
<l abel >Travel Request</| abel >

<post Processor Nanme>or g. kual i . ri ce. kns. wor kf | ow. post processor. Kual i Post Processor </ post Processor Nanme>

<super User G oupNarme nanespace="TVL" >Super User G oup</ super User Gr oupNane>
<bl anket Appr oveG oupNane nanmespace="TVL" >Bl anket Appr oveG oup</ bl anket Appr oveG oupNane>
<def aul t Excepti onGr oupNanme nanespace="TVL" >Excepti onG oup</ def aul t Excepti onG oupNane>

<docHandl er >${ appl i cation. url}/travel Docunent 2. do?net hodToCal | =docHandl er </ docHandl er >
<r out ePat hs>
<r out ePat h>
<start name="Initiated" nextNode="Desti nati onApproval" />
<requests nanme="Desti nati onApproval " next Node="Travel er Approval * />
<requests name="Travel er Approval " next Node="Supervi sor Approval " />
<requests nanme="Supervi sor Approval " next Node="Account Approval " />
<requests nanme="Account Approval " />
</ r out ePat h>
</ r out ePat hs>
<r out eNodes>
<start name="|nitiated">
<activationType>P</activati onType>
</start>
<requests nanme="Desti nati onApproval ">
<rul eTenpl at e>Tr avel Request - Dest i nati onRout i ng</rul eTenpl at e>
</ request s>
<requests name="Travel er Approval ">
<rul eTenpl at e>Tr avel Request - Tr avel er Rout i ng</rul eTenpl at e>
</ request s>
<requests nanme="Supervi sor Approval ">
<rul eTenpl at e>Tr avel Request - Super vi sor Rout i ng</ r ul eTenpl at e>
</ request s>
<requests name="Account Approval ">
<rul eTenpl at e>Tr avel Request - Account Rout i ng</ rul eTenpl at e>
</ request s>
</ r out eNodes>
</ docunent Type>
</ docunent Types>
</ dat a>

TravelRuleAttributes.xml — Defines the attributes used by the Workflow Engine to determine to whom

to route to next:

<?xm version="1.0" encodi ng="UTF-8"?>

<data xm ns="ns: wor kfl ow' xml ns:xsi="http://ww:.w3. org/ 2001/ XM_Schema- i nst ance" xsi:schenmaLocati on="ns: wor kfl ow

resour ce: Wr kf | owDat a" >
<rul eAttributes xm ns="ns: workfl ow Rul eAttribute" xsi:schemaLocation="ns:workfl ow Rul eAttribute
resource: Rul eAttribute">
<rul eAttri bute>
<name>Enpl oyeeAt tri but e</ name>
<cl assNane>edu. sanpl eu. travel . wor kf | ow. Enpl oyeeAt t ri but e</ cl assNanme>
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<l abel >Enpl oyee Routing</| abel >
<descri pti on>Enpl oyee Routing</description>
<servi ceNamespace>TRAVEL</ ser vi ceNanmespace>
<type>Rul eAttri bute</type>

</rul eAttribute>

<rul eAttri bute>
<nanme>Account At t ri but e</ nane>
<cl assNane>edu. sanpl eu. travel . wor kf | ow. Account At t ri but e</ cl assNane>
<l abel >Account Routi ng</I| abel >
<descri pti on>Account Routing</description>
<servi ceNamespace>TRAVEL</ ser vi ceNanmespace>
<type>Rul eAttri bute</type>

</rul eAttribute>

</rul eAttributes>
</ dat a>

TravelRuleTemplatesxml - Defines the RuleTemplates that represent each routeNode listed in the
Document Type configuration:

<?xm version="1.0" encodi ng="UTF-8"?>
<data xm ns="ns: wor kfl ow' xml ns:xsi="http://ww:.w3. org/ 2001/ XM_Schema- i nst ance" xsi:schenmaLocati on="ns: wor kf| ow
resour ce: Wor kf | owDat a" >
<rul eTenpl at es xm ns="ns: wor kf | ow/ Rul eTenpl ate" xsi:schenalLocati on="ns: wor kf | ow Rul eTenpl at e
resour ce: Rul eTenpl ate" >
<rul eTenpl ate al |l owOverwite="true">
<name>Tr avel Request - Dest i nati onRout i ng</ nane>
<descri ption>Destinati on Routing</description>
<attributes>
<attribute>
<nane>Desti nati onAttri but e</ name>
</attribute>
</ attributes>
</rul eTenpl at e>
<rul eTenpl ate al |l owOverwite="true">
<name>Tr avel Request - Travel er Rout i ng</ name>
<descri ption>Travel er Routing</description>
<attributes>
<attribute>
<name>Enpl oyeeAt tri but e</ narme>
</attribute>
</ attributes>
</rul eTenpl at e>
<rul eTenpl ate al | owOverwite="true">
<name>Tr avel Request - Super vi sor Rout i ng</ nane>
<descri pti on>Supervi sor Routing</description>
<attributes>
<attribute>
<name>Enpl oyeeAt tri but e</ name>
</attribute>
</ attributes>
</rul eTenpl at e>
<rul eTenpl ate al |l owOverwite="true">
<name>Tr avel Request - Account Rout i ng</ nane>
<descri ption>Travel Account Routing</description>
<attributes>
<attribute>
<name>Account At t ri but e</ nane>
</attribute>
</ attributes>
</rul eTenpl at e>
</ rul eTenpl at es>
</ dat a>

TravelRulesxml - Defines the rules (a rule is a combination of Document Type, Rule Template and
Responsibilities) that the workflow engine uses to determine to whom to route to next:

<?xm version="1.0" encodi ng="UTF-8"?>
<data xm ns="ns: wor kfl ow' xml ns:xsi="http://ww.w3. org/ 2001/ XM_Schema- i nst ance" xsi:schenmaLocati on="ns: wor kfl ow
resour ce: Wr kf | owDat a" >
<rul es xm ns="ns: wor kfl ow Rul e" xsi:schenmaLocati on="ns: workfl ow Rul e resource: Rul e">
<rul e>
<name>Tr avel Request - Dest i nat i onLasVegas</ name>
<docurnent Type>Tr avel Request </ docunent Type>
<rul eTenpl at e>Tr avel Request - Dest i nat i onRout i ng</rul eTenpl at e>
<descri ption>Destinati on Rul e</description>
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<r ul eExt ensi ons>
<r ul eExt ensi on>
<attribute>DestinationAttribute</attribute>
<rul eTenpl at e>Tr avel Request - Dest i nati onRout i ng</rul eTenpl at e>
<r ul eExt ensi onVal ues>
<r ul eExt ensi onVal ue>
<key>desti nati on</ key>
<val ue>l as vegas</val ue>
</ rul eExt ensi onVal ue>
</ rul eExt ensi onVal ues>
</ rul eExt ensi on>
</ rul eExt ensi ons>
<responsi bilities>
<responsi bility>
<pri nci pal Name>user 4</ pri nci pal Nane>
<acti onRequest ed>A</ acti onRequest ed>
</responsibility>
</responsibilities>
</rul e>
<rul e>
<name>Tr avel Request - Enpl oyeeRol e</ nanme>
<docunent Type>Tr avel Request </ docunent Type>
<rul eTenpl at e>Tr avel Request - Tr avel er Rout i ng</rul eTenpl at e>
<descri ption>Travel er Routing</description>
<responsi bilities>
<responsi bility>
<rol e>edu. sanpl eu. travel . wor kf | ow. Enpl oyeeAt tri but e! enpl oyee</rol e>
<acti onRequest ed>A</ acti onRequest ed>
</responsi bility>
</responsibilities>
</rul e>
<rul e>
<name>Tr avel Request - Super vi sor Rol e</ nanme>
<docunent Type>Tr avel Request </ docunent Type>
<rul eTenpl at e>Tr avel Request - Super vi sor Rout i ng</rul eTenpl at e>
<descri pti on>Supervi sor Routing</description>
<responsi bilities>
<responsi bility>
<rol e>edu. sanpl eu. travel . wor kf | ow. Enpl oyeeAttri bute! supervisr</rol e>
<acti onRequest ed>A</ acti onRequest ed>
</responsi bility>
</responsibilities>
</rul e>
<rul e>
<name>Tr avel Request - Di r ect or Rol e</ name>
<docunent Type>Tr avel Request </ docunent Type>
<rul eTenpl at e>Tr avel Request - Super vi sor Rout i ng</rul eTenpl at e>
<descri pti on>Dean/ Di rect or Routing</description>
<responsi bilities>
<responsi bility>
<rol e>edu. sanpl eu. travel . wor kf | ow. Enpl oyeeAttri bute! director</rol e>
<acti onRequest ed>K</ acti onRequest ed>
</responsi bility>
</responsibilities
</rul e>
<rul e>
<name>Tr avel Request - Fi scal Of fi cer Rol e</ name>
<docunent Type>Tr avel Request </ docunent Type>
<rul eTenpl at e>Tr avel Request - Account Rout i ng</rul eTenpl at e>
<description>Fiscal Oficer Routing</description>
<responsi bilities>
<responsi bility>
<rol e>edu. sanpl eu. travel . wor kf | ow. Account Attri but e! FO</ r ol e>
</responsi bility>
</responsibilities>
</rul e>
</rul es>
</ dat a>

Client PlugIn Steps

Your plugin should contain Java classes that correspond to the attributes defined in the XML
configuration file. The Travel Request Sample Client contains two attribute classes: EmployeeAttribute
and AccountAttribute. Each of these classes implements these two interfaces:

44



KEW

org. kuali.rice.kew rule. Rol eAttribute
org. kuali.rice.kew rule.WorkflowAttribute

Using the EmployeeAttribute as an example, here are the implementations for the Rol eAttribute interface:

getRoleNames() - Returns a list of role names to display on the routing rule GUI in the KEW web
application:

private static final Map ROLE_|I NFO
static {

ROLE_I NFO = new TreeMap();

ROLE_I NFO. put (EMPLOYEE_ROLE_KEY, "Enpl oyee");
ROLE_I NFO. put ( SUPERVI SOR_RCLE_KEY, "Supervisor");
ROLE_I NFO. put (DI RECTOR_ROLE_KEY, "Dean/Director");

}

public List getRoleNames() {
Li st rol eNames = new ArrayList();
for (lterator iterator = roles.keySet().iterator(); iterator.hasNext();) {
String roleNane = (String) iterator.next();
rol eNanes. add(new Rol e(get d ass(), rol eNanme, rol eNane));

return rol eNanes;

}
getQualifiedRoleNames() - Returns alist of strings that represents the qualified role name for the given
roleName and XML docContent which is attached to the workflow document:
/**
* Returns a String which represent the qualified role name of this role for the given
* rol eNane and docContent.
* @aramrol eNane the role name (without class prefix)
* @ar am docunent Content the docunent content
*/

public List<String> getQualifiedRol eNanes(String rol eNane, Docurnent Content docunent Content) {
Li st<String> qualifiedRol eNames = new ArraylList<String>();
Map<String, List<String>> qualifiedRoles = (Map<String, List<String>>)roles.get(roleNane);
if (qualifiedRoles != null) {
qual i fi edRol eNanes. addAl | (qual i fi edRol es. keySet());
} else {
throw new ||| egal Argument Exception("TestRul eAttri bute does not support the given role

+ rol eNane) ;

}
return qualifiedRol eNanes;
}
resolveQualifiedRole() - Returns alist of workflow users that are members of the given Qualified Role.
(Used to help determine to whom to route the document.):
/**

* Returns a List of Workflow Users which are nenbers of the given qualified role.
* @aram rout eCont ext the RouteContext
* @aramrol eName the rol eNanme (without class prefix)
* @aramqual ifiedRole one of the the qualified role names returned fromthe {@ink
#get Qual i fi edRol eNames(String, DocunentContent)} method
* @eturn Resol vedQualifiedRol e containing recipients, role |abel (npbst likely the roleNanme), and an
annot ati on
*/

public Resol vedQualifiedRol e resol veQual i fi edRol e( Rout eCont ext routeContext, String roleNane, String
qualifiedRole) {
Resol vedQual i fi edRol e resol ved = new Resol vedQual i fi edRol e();
Map<String, List<String>> qualifiedRoles = (Map<String, List<String>>)roles.get(roleNane);

if (qualifiedRoles !'= null) {
Li st<String> recipients = (List<String>)qualifiedRoles.get(qualifiedRole);
if (recipients !'=null) {
resol ved. set Qual i fi edRol eLabel (qual i fi edRol e);
resol ved. set Reci pi ents(convertPrincipal | dLi st (reci pients));
} else {
throw new ||| egal Argument Exception("TestRul eAttri bute does not support the qualified role " +
qualifiedRol e);
}
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} else {
throw new |11 egal Argunment Excepti on(" Test Rul eAttribute does not support the given role " + rol eNane);
}

return resol ved;

Using the EmployeeAttribute example, here are the implementations for the Wor kflowAttribute interface:

getRoutingDataRows() — Returns a list of RoutingDataRows that contain the user interface level
presentation of the ruleData fields. KEW uses the ruleData fields to determine where a given document
would be routed according to the associated rule:

public List<Row> get RoutingDataRows() {
Li st <Row> rows = new ArrayLi st <Row>();
List<Field> fields = new ArrayLi st<Fi el d>();
fields.add(new Fiel d("Travel er usernanme", "", Field. TEXT, false, USERI D FORM FI ELDNAME, "", false, false,
null, null));
rows. add(new Row(fields));
return rows;

getDocContent() - Returns a string containing this Attribute's routingData values, formatted as a series
of XML tags:

public String getDocContent() {
String docContent = "";

if (I'sStringUtils.isBlank(_uuid)) {
String uuidContent = Xm Utils. encapsul at e( UUl D_PARAMETER TAGNAME, _uui d);

docContent = _attributeParser.w apAttributeContent(uuidContent);
}

return docContent;

validateRoutingData() - Validates routingData values in the incoming map and returns a list of errors
from the routing data. (The user interface calls validateRoutingData() during rule creation.):

public List validateRoutingData(Map paranivap) {
List errors = new ArraylList();

String principalName = StringWils.trim((String) paranmvap. get (PRI NCI PAL_NAMVE_FORM FI ELDNAME) ) ;
if (isRequired() && StringUtils.isBlank(principal Nane)) {
errors. add(new Workfl owServi ceErrorlnpl ("princi pal Name is required”,
"accountattribute. principal Nane.required"));

}

if (!'StringUils.isBlank(principal Name)) {
Ki nPrinci pal Info principal =
Kl MSer vi ceLocat or . get I denti tyServi ce().getPrincipal ByPrinci pal Nane(princi pal Nane) ;

if (principal == null) {
errors. add(new Workfl owServi ceErrorlnpl ("unable to retrieve user for principal Nanme '" +
principal Name + "'", "accountattribute.principal Name.invalid"));
}
if (errors.size() ==0) {

_principal Nane = princi pal Nang;
}

return errors,

}

Build PostProcessor and Services

The PostProcessor class should implement the interface:
org. kuali.rice. kew. postprocessor. Post Processor Renot e
Y ou should use this interface for business logic that should execute when the document transitions to a

new status or when actions are taken on the document. The PostProcessor for the Travel Request Client
istheclass:
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org. kual i .rice. kns. workfl ow. post processor. Kual i Post Processor

that implements the doRouteStatusChange() method to update the status of the travel document in the
Travel database. The KualiPostProcessor in this case is the standard PostProcessor used on al documents
that are built on the KNS framework.

Package Pluglin

Depending on how the application has been developed (i.e. embedded workflow engine vs. using the
engine asaremote service) it may be necessary to package components like the PostProcessor into a plug-
in. See the Workflow Plugln Guide for details on how to do this.

Client Web Application Steps

Build the Web Application

Beginto build aKuali Enterprise Workflow the same asyou build any other Java-enabled web application.
Youbuilditwith all thebusinesslogic for the application and, for example, communication to theworkflow
engine using web services.

As an example, the Travel Request Client Web Application uses Struts, Spring, and OJB.

Build the Service that Connects to the Workflow Engine

For therest of thissection, thisguiderefersto the Javaapplication communicating with the Kuali Enterprise
Workflow as the Client Application. The Client Application needs a service that will interact with the
workflow system. This service will perform actions such as locating a document in the workflow system
and routing the document.

Below are examples from the Travel Request Sample Client. The methods in the Travel DocumentService
class find a TravelDocument in the workflow system, save and route a Travel Document, and validate a
TravelDocument.

findByDocHeader1d() - Finds a Document in the workflow engine:

public Travel Docunent findByDocHeader!d(Long docHeaderld, String principalld) {
if (docHeaderld == null) {
throw new I egal Argunent Exception("invalid (null) docHeaderld");

}

Travel Docunment result = travel Docunent Dao. fi ndByDocHeader | d( docHeader | d) ;
if (result !'=null) {
/1 convert DocAccountJoins into Financial Accounts
ArraylLi st accounts = new ArrayList();
for (lterator joins = result.getDocAccountJoins().iterator(); joins.hasNext();) {

Docunent Account Join join = (Docunment AccountJoin) joins.next();
Fi nanci al Account account = financial Account Servi ce. fi ndByAccount Nunber (j oi n. get Account Nunber ());

accounts. add(account);

resul t. set Fi nanci al Account s(accounts);
try {

Wor kf | owDocunent docunent = new Wor kf | owDocunent ( principal 1d, result.getDocHeaderld());

} catch (Workfl owException e) {

}
}

LOG error ("caught Workfl owException: ", e);
t hrow new Runti neException(e);

return result;

The TravelDocumentServicelmpl class populates the attribute values on the workflow document
(Employee, Account) that will be used for future routing. It doesthis by calling its getEmpl oyeeAttribute()
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and getAccountAttribute() methods and adding the results to the workflow document by calling the
addAttributeDefinition() method.

private Workfl owAttributeDefinitionVO get Enpl oyeeAttri bute(Travel Docunent travel Docunent) {
Wor kf | owAt t ri but eDefinitionDTO attrDef = new
Wor kf | owAt t ri but eDef i niti onDTQ( " edu. sanpl eu. travel . wor kf | ow. Enpl oyeeAttri bute");
String principal Name = travel Docunent. get Travel er User nane() ;
att r Def . addConst r uct or Par anet er (pri nci pal Nane) ;
return attrDef;

private List getAccountAttributes(Travel Docunent travel Docunent) {

Li st accounts = travel Docunent. get Fi nanci al Accounts();

Li st accountAttributes = new ArraylList();

for (lterator accountlterator = accounts.iterator(); accountlterator.hasNext();) {
Wor kf | owAt t ri but eDefinitionDTO attrDef = new

Wor kf | owAt t ri but eDefi niti onDTQ( " edu. sanpl eu. travel . wor kf | ow. Account Attri bute");

Fi nanci al Account account = (Financi al Account)accountlterator.next();
at tr Def. addConst ruct or Par anet er (account . get Account Nunber ());
account Attributes.add(attrDef);

}

return accountAttributes;

Build the Action Class with Workflow Lifecycle Methods

In the Travel Request Sample Client, the WorkflowDocHandler Action struts action class calls the
workflow lifecycle methods (approve, acknowledge, etc.) on the workflow document.

WorkflowDocHandler Action - Take approve action. (Each workflow action - acknowledge, complete,
etc. - islike this):
public ActionForward approve(Acti onMappi ng mappi ng, ActionForm form HtpServletRequest request,
Ht t pSer vl et Response response) throws Exception {
LOG i nfo("entering approve() method ...");
DocHandl er For m docHandl er Form = (DocHandl er Form) form
Wor kf | owDocunent docunment = docHandl er For m get Wor kf | owDocunent ()
docurnent . appr ove( docHandl er For m get Annot ation());
saveDocunent Acti onMessage( " general . routi ng. approved", request);

LOG i nfo("forwarding to actionTaken from approve()");
return mappi ng. fi ndForwar d("acti onTaken");

Set up the WorkflowDocument in the initializeBaseFor mState() method of the DispatchActionBase
from which the Struts action classes inherit. Obtain the workflow document with this line of code:

String principalld = getUserSession(request).getPrincipalld();
Wor kf | owDocunent docunment = new Wor kf | owDocunent (princi pal 1 d, docld);

Package the Web Application

Package the Client Application (client web application) for deployment the way you normally package
web applications. The Travel Request Sample Web Application does this with an Ant build script. The
dist step of the build.xml script builds the SampleWor kflowClient.war file.

Final Steps

Deploy the Plugin

Deploy the plugin to your workflow installation. Copy the plugin directory structure to your application
plugins directory. Please see the Workflow Plugin Guide for more information.
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Deploy the Client Web Application

Deploy the Client Web Application to your Application server the way you normally deploy web

applications.

KEW Configuration

KEW Integration Options

The following integration options are available to applications integrating with KEW:

* Embedded - The KEW engine is embedded into a Java application. The Standalone Rice Server is

required.

» Bundled - Same as Embedded mode except that the entire KEW web application is also embedded into
the Java application. The Standalone Rice Server is not required.

» Remote Java Client — A Java client is used which relies on the service bus to communicate with a
Standalone Rice Server's KEW services.

* Thin Java Client - A thin Javaclient is used which communicates with a Standal one Rice Server over

remote service cals.

» Web Services - Interacts directly with web services on a Standalone Rice Server.

Table 3.1. Advantages/Disadvantages of KEW Integration Options

Integration Option

Advantages

Disadvantages

Embedded

Integration of database transactions between
client application and embedded KEW (via
JTA)

Performance - Embedded client talks directly
to database

No need for application plug-ins on the server

Great for Enterprise deployment, thereisstill a
single shared Standal one Rice web application
but scalability isincreased because of multiple
Workflow Engines

Can only be used by Java clients

More library dependencies than the Thin
Client model

Requires client application to establish
connections to Kuali Rice database

Bundled

All the advantages of Embedded Mode
No need to deploy a standalone Rice server

Ideal for
applications

development or "quickstart”

Application can be bundled with Rice for ease
of development/distribution

Can switch to Embedded Mode
deployment in an Enterprise environment

for

Not desirablefor Enterprise deployment where
more than one application is integrated with
Rice and KEW

More library dependencies than the Thin
Client model and Embedded Mode (additional
web libraries)

Remote Java Client

Relatively simple configuration

Client can access more external KEW services
from the Standal one Rice Server than the Thin
Java Client, and yet the client does not need to
have an embedded KEW engine

Requires client application to be KSB-
enabled, unlike the Thin Java Client

Cannot be used by KNS-enabled client
applications

Thin Java Client » Relatively simple configuration * No transactional integration between client
and server
» Fewer Library Dependencies
¢ Plug-ins must be deployed to the server if
custom routing components are needed
Web Services * Any language which supports web services|s No transactional integration between client

can be used

and server
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Integration Option Advantages Disadvantages
¢ Plug-ins must be deployed to the server if
custom routing components are needed

*« Web Services can be slower than other
integration options

Standalone Server

To effectively use any of the KEW integration modes besides bundled, a Standal one Rice Server will need
to be deployed.

Embedded Deployment Diagram

Hereisadiagram illustrating what a sample embedded deployment might look look.

Figure 3.1. Embedded Deployment Diagram example
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Bundling the KEW Application

web.xml

Bundled mode is the same as embedded mode except that the client application embeds the entire Kuali
Rice system within it (including the web application). The embedding of the web application portion is
accomplished by utilizing Struts Modules.
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Configuration is the same as embedded mode, with the exception of loading the web application portions
in the web.xml:

<filter>
<filter-nanme>UserLoginFilter</filter-nane>
<filter-class>org. kuali.rice. kew web. UserLoginFilter</filter-class>

</filter>

<filter-mappi ng>
<filter-nanme>UserLoginFilter</filter-nane>
<servl et - name>act i on</ servl et - nane>
</filter-nmappi ng>

<servl et>
<servl et - name>act i on</ servl et - nane>
<servl et-cl ass>org. apache. struts. acti on. Acti onServl et</servl et-class>
other struts configuration if applicable
<init-paranp
<par am nane>confi g/ en</ par am nanme>
<par am val ue>/ en/ EB- | NF/ st rut s- confi g. xm </ par am val ue>
</init-paranm>
<l oad- on- st art up>0</ | oad- on- st art up>
</servl et>

<servl et>
<servl et - name>r enot i ng</ servl et - nanme>
<servl et-class>org. kual i . rice. ksh. messagi ng. servl et. KSBDi spat cher Servl et </ servl et - cl ass>
<l oad- on- st art up>1</| oad- on- st art up>

</servl et>

<servl et>

<servl et - name>export </ servl et - nanme>

<servl et-class>org. kuali.rice.kew export.web. Export Servl et </servl et-class>
</servl et>

<servl et>

<servl et - name>at t achnment </ ser vl et - nanme>

<servl et-class>org. kual i . ri ce. kew. not es. web. Attachment Servl et </ servl et-cl ass>
</servl et>

<servl et>

<servl et - name>edocl i t e</ servl et - nane>

<servl et-class>org. kuali.rice.kew edl . EDLServl et </servlet-class>
</servl et>

<servl et - mappi ng>
<servl et - name>r enot i ng</ servl et - nanme>
<url-pattern>/renoting/*</url-pattern>
</ servl et - mappi ng>

<servl et - mappi ng>
<servl et - name>act i on</ servl et - nane>
<url-pattern>*.do</url-pattern>

</ servl et - mappi ng>

<servl et - mappi ng>
<servl et - name>export </ servl et - nanme>

<url -pattern>/export/*</url-pattern>
</ servl et - mappi ng>
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<servl et - mappi ng>

<servl et - name>at t achnent </ ser vl et - name>
<url-pattern>/en/attachment/*</url-pattern>
</ servl et - mappi ng>

<servl et - mappi ng>
<servl et - name>edocl i t e</ servl et - nane>
<url -pattern>/en/ EDocLite</url -pattern>
</ servl et - mappi ng>

<filter>

org.kuali.rice.kew.web.UserLoginFilter — Thisfilter isused to assist the KEW bundled web application
in determining who the authenticated user is. Specificaly, the login filter invokes the KIM identity
management service to determine the identity of the authenticated user.

Typically, a previously executed filter will challenge the user on entry to a Rice web page for their
authentication credentials using CAS or some other form of single sign on (SSO) authentication system.

For development and testing purposes, Rice provides a simple filter implementation that will present a
simple sign on screen. This screen displays only a single login entry field and submit button. The user
can enter their username (no password) and press the submit button, and the system authenticates the user
for entry into the system.

This can be configured as follows in the web.xml:

<filter-nane>LoginFilter</filter-name>
<filter-class>org. kuali.rice. kew web. UserLoginFilter</filter-class>

</filter>

<filter-mappi ng>
<filter-nane>LoginFilter</filter-name>
<servl et - name>act i on</ servl et - nane>
</filter-nmappi ng>

and in therice-config.xml:

<param nane="filter.login.class">org. kuali.rice.kew web. DunmyLogi nFi | t er </ par am>
<param nane="fi | t er mappi ng. | ogi n. 1" >/ *</ par an>

org.apache.struts.action.ActionServlet - The Struts servlet which loads the KEW Struts module. The
module name should be 'en'. Struts only allows a single Action Servlet so if you are using Struts in your
application, all of your Struts modules will need to be configured using the init-param elements in this
servlet definition.

org.kuali.rice.ksh.messaging.servlet.K SBDispatcher Servlet - A servlet which dispatches http requests
for the Kuali Service Bus (see KSB documentation for more details). The servliet mapping here should
correspond to the serviceServletUr| configuration parameter for the KSBConfigurer.

org.kuali.rice.kew.export.web.ExportServlet - serves exports of lookup results as XML files

org.kuali.ricekew.notes.web.AttachmentServlet - serves attachments that have been attached to
documents using the KEW Notes and Attachments framework

org.kuali.rice.kew.edl.EDL Servlet - The servlet used to interact with eDocLite documents. SeeeDocL ite
documentation for more information.
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Bundled Deployment Diagram

Figure 3.2. Bundled deployment diagram
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Using the Remote Java Client

Along with the previous embedded configurations, KEW also alows for Remote Java Clients, which
communicate with KEW services that are available on the service bus. Configuration of the remote client
issimilar to that of the embedded client, except that no embedded KEW engine gets set up; instead, the
client relies on the service bus for accessing the KEW services of the Standalone Rice Server.

Caution

Limitations of Remote KEW Java Clients:

At present, KNS-enabled Java clients cannot be used as Remote KEW Java Clients.

Using the Thin Java Client

In addition to the embedded configurations discussed previously, KEW also provides a thin java client
which can be used to talk directly to two KEW services exposed on the service bus.

These KEW services are:

» WorkflowDocumentService - provides methods for creating, loading, approving and querying
documents
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» WorkflowUtilityService - provides methods for querying for various pieces of information about the
KEW system

Additionally, accessto two KIM servicesisrequired, as Principal and Group information is needed to use
many of the methods in the KEW services above.

These KIM services are:
 kimldentityService - provides methods to query for Principal and Entity information
» kimGroupService - provides methods to query for Group information

Of course, this configuration requires Standal one Rice Server deployment. The workflow engine deployed
within Standalone Rice Server is used for processing documents that integrate using athin client.

These services are exposed on the KSB as Java services, meaning they use Java Serialization over HTTP
to communicate. Optionally, the KEW services can also be secured to provide access to only those callers

with authorized digital signatures (note that secure access is required for the KIM services). In order to
configure the thin client, the following configuration properties need to be defined.

Required Thin Client Configuration Properties

Table 3.2. Required Thin Client Configuration Properties

Property Description
encryption.key The secret key used by the encryption service; Must match the setting on
the standal one server

keystore.aias Alias of the application's key within the keystore
keystorefile Path to the application's keystore file
keystore.password Password to the keystore and the key with the configured alias
workflowdocument.javaservice.endpoint Endpoint URL for the Workflow Document service
workflowutility.javaservice.endpoint Endpoint URL for the Workflow Utility service
identity.javaservice.endpoint Endpoint URL for the KIM identity service
group.javaservice.endpoint Endpoint URL for the KIM group service

Note

Itissimplest to use anidentical keystore file and configuration in your thin client application to
that on your standalone server.

Optional Thin Client Configuration Properties

Table 3.3. Optional Thin Client Configuration Properties

Property Description

secure.workflowdocument.javaservice.endpoint true/false value indicating if endpoint is secured (defaults to true); Must
match the setting on the standal one server

secure.workflowutility.javaservice.endpoint true/false value indicating if endpoint is secured (defaults to true); Must
match the setting on the standal one server

Thin Client Spring Configuration

Here isthe Spring configuration for athin client in ThinClientSpring.xmi:
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<! DOCTYPE beans PUBLIC "-//SPRI NG /DTD BEAN /EN' "http://ww. spri ngframework. org/ dtd/ spring-beans. dtd">

<beans>
<l-- point Ricetothe file containing your configuration parans -->
<bean id="config" class="org.kuali.rice.core.config.spring.ConfigFactoryBean">
<property name="configLocations">

<list>
<val ue>cl asspat h: your Thi nC i ent App- confi g. xm </ val ue>
</list>
</ property>
</ bean>
<!-- Pull your configuration parans out as Properties -->

<bean i d="confi gProperties"
cl ass="org. spri ngfranewor k. beans. fact ory. confi g. Met hodl nvoki ngFact or yBean" >
<property name="t arget Gbj ect" ref="config" />
<property name="t ar get Met hod" val ue="get Properties" />
</ bean>
<!-- expose configuration params to Spring -->
<bean cl ass=
"org. springfranewor k. beans. factory. config. PropertyPl acehol der Confi gurer">
<property name="properties" ref="configProperties" />

</ bean>
<!-- The RiceConfigurer that sets up thin client node -->
<bean id="rice" class="org.kuali.rice.kew config.Thind ient KEWConfi gurer">
<l-- inject the "config" bean into our configurer -->
<property name="root Config" ref="config" />
</ bean>
</ beans>

Endpoint URLs

Since KEW and KIM use the KSB to expose their services, the endpoint URLSs are the same as those
exported by the KSB.

An example configuration for these might be:

<par am nane=

"wor kf | ondocunent . j avaser vi ce. endpoi nt">http://yourl ocal i p/ kr-dev/renoting/ Wrkfl owDocunent Acti onsSer vi ce</
par an»

<par am nane=

"wor kfl owutility.javaservice.endpoint">http://yourlocalip/kr-dev/renoting/ WrkflowlkilityService</paran>
<par am nane=

"identity.javaservice.endpoint">http://yourlocalip/kr-dev/renoting/kimdentityService</paran>

<par am nane=

"group.javaservice. endpoi nt">http://yourl ocal i p/kr-dev/renoting/ ki nGroupSer vi ce</ par an>

Thin Client Deployment Diagram

Here is a diagram showing what a thin client deployment might look like.
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Figure 3.3. Thin client deployment diagram
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Picture of an Enterprise Deployment

As can be seen from the various integration options described, a KEW Enterprise Deployment (and Kuali
Ricein general) might very well be a distributed environment with multiple systems communicating with
each other.

The diagram below shows what a typical Enterprise deployment of Kuali Rice might look like.
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Figure 3.4. Typical enterprise deployment of Kuali Rice
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KEW Core Parameters

The display below includes those basic set of parameters for rice-config.xml as the minimal parameters

to startup the Rice software. These parameters are a beginning reference to you for modification to your
rice-config.xml.

Note
Please verify that your application.url and database username/password are set correctly.

Table3.4. KEW Core Parameters

Core Description Examples\Vaues
workflow.url URL to the KEW web module (i.e,

${ application.url}/en)
plugin.dir Directory from which plugins will be loaded
attachment.dir.location Directory where attachments will be stored

As aminimum, you must enable the dummy login filter by adding these lines to the rice-config.xml file
for default login screen:

<param nanme="filter.login.class">org. kuali.rice.kew web. DunmyLogi nFi | t er </ par an>
<param nanme="fi | t er mappi ng. | ogi n. 1" >/ *</ par an>
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KEW Configuration Properties

Table 3.5. KEW Configuration Properties

Property Description Default
actionlist.outbox Determines if the KEW actionlist "outbox" (ie, | false
the actions already completed) will be viewable
by users of the Rice application.
actionlist.outbox.default.preference.on Determinesif the KEW actionlist "outbox" isthe| false

default mode for viewing the action list.

base.url Base URL under which Action List and other | Example: if your action list URL is http:/
KEW screens can be found yourlocalip/en/ActionList.do, set this property to
http://yourlocali
client.protocol Same as clientProtocol  property  on|embedded

KEWConfigurer, this property can be configured
in either place

data.xml.root.location

The temporary location of files being processed
by the KEW XmlPollingService

Itmp/${ environment} /kew/xml

document.lock.timeout

Used by the Oracle database platform to
determine how long database locks on the
document header are used

email.reminder.lifecycle.enabled

If true, turns on timed job to send out regular e
mails to remind users of actions still waiting in
their action list

extra.classes.dir

Directory where classes for KEW plugins are
located

extralib.dir Directory where libraries for KEW plugins are
located
kew.mode The mode that KEW will run in; choices are|loca
"local", "embedded", "remote”, or "thin"
kew.url The base URL of KEW services and pages ${ application.url}/kew
plugin.dir Directory to load plugins from if the Plugin
Registry is enabled
plugin.registry.enabled If set to true, then the Plugin Registry will be|false

enabled and any available pluginswill be loaded
(see Workflow Plugin Guide)

attachment.dir.location

When using the attachments system, this is the
directory where attachments will be stored

data.xml.loaded.location

Directory path where the XML Loader will store
successfully loaded XML files

data.xml.pending.location

Directory path where the XML Loader will look
for filesto ingest

dataxml.pollInterval Secs

Interval in secondsthat the XML Loader will poll
the pending directory for new XML filesto load

data.xml.problem.location

Directory path where the XML Loader will put
XML filesit failed to load

datasource.platform

The fully qualified class name
of an implementation of the
org.kuali.rice.core.database.platform.Platform
interface

default.note.class

The fully qualified class name
of the  default implementation of
org.kuali.rice.kew.notes.CustomNoteAttribute
to use for the Notes system

org.kuali.rice.kew.notes.CustomNoteAttributel mpl

edl.config.loc Location to load the EDocLite component | classpath:META-INF/EDL Config.xml
configuration from
embedded.server Indicatesif an embedded instanceis supposed to | false

behave like a standalone server. See additional
notes below under embedded.server

Identity.useRemoteServices

Configuration parameter that governs whether a
number of common identity services (user and
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Property Description Default

group service) are exported or retrieved via the
bus. If thisflag is set to true then:

1. user and group servicewill NOT be published
the bus, and

2. CoreResourceLoader will short-circuit the
resource loader stack lookup and go directly
to the bus to obtain these services,
circumventing any beans that may be defined

by local modules.
initial DelaySecs Delay in seconds after system starts up to begin
the XML Loader polling
rice.kew.enableK ENNotification Determines if KCB notifications should be sent | true

for KEW events when Action Item events occur

rice.kew.struts.config.files The struts-config.xml configuration file that the | /kew/WEB-INF/struts-config.xml
KEW portion of the Rice application will use

workflow.documentsearch.base.url The URL for the document search page ${ workflow.url}/DocumentSearch.do?
docFormK ey=88888888& amp;returnL ocation=
${ application.url}/

portal.do& amp;hideReturnLink=true

xml.pipelinelifecycle.enabled If set to true, will poll a directory for new Rice|false
configuration XML and ingest any new XML
placed in that directory

The ‘embedded.server’ Parameter

If embedded.server parameter is enabled (set to true), then two additional features will be loaded when
KEW is started:

1. XML Loader
2. Email Reminders

The XML Loader will poll a directory for XML files to ingest into the system (as configured by the
dataxml.* properties).

The Email Reminders will handle sending Daily and Weekly batch emails for users that have their
preferences set accordingly.

The ‘datasource.platform’ Parameter

KEW requires and uses the database platform implementation in order to function. These may be be
implemented differently for each support database management system.

The current functional implementations of this platform are:
* org.kuadli.rice.core.database.platform.OraclePlatform

« org.kuali.rice.core.database.platform.Oracle9iPlatform (deprecated and just an aias for the
OraclePlatform)

» org.kuali.rice.core.database.platform.MySQL Platform
Custom Servlet Filters
When running a Standalone Rice Server, you may want to implement your own filters for authentication

purposes. The system comes with a special filter that will read filter definitions and mappings from the
configuration system.
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The Bootstrap Filter isagenericfilter that is applied to all web requests, which then delegatesto any filters
and are setup through the default configuration. This mechanism allows registration of institution-specific
filters without the necessity of modifying the web application configuration file (/WEB-INF/web.xml)
within the standal one webapp.

Filter syntax is asfollows:

<param name="filter.filter name.class">class nanme of filter</paranm>

filter nameis an arbitrary name for your filter:

<param nanme="filter.nyfilter.class">edu.institution.organization. MyFilter</paran>

Any number of configuration parameters may be defined for a given filter asfollows:

<param narme="filter.filter name.filter param nanme">filter param val ue</parane

For example:
<param nanme="filter.nyfilter.col or">red</paranr
<param name="filter.nyfilter.shape">square</ paran>
For custom filtersto be invoked, they must first be mapped to requests. That is done viathe filter mapping
parameter:
<param nane="filtermapping.filter name.optional order index">path matching expression</paran>
filter name is the name of your previously defined filter, optional order index is an optional integer used

to specify the position of the filter in the invocation order, and path matching expression is a Servlet-
specification-compatible url pattern.

<param name="fil termappi ng. nyfilter.1">/speci al / pat h/ </ par an»>
If an order index is not specified, it isassumed to be 0. Filters with equivalent order are ordered arbitrarily
with relation to each other (not in order of filter or mapping definition). A full example follows:

<param nane="filter.nyfilter.class">edu.institution.organization. MFilter</paran>

<param name="filter.nyfilter.col or">red</parans>

<param name="filter.nyfilter.shape">square</ parans
<param nane="filter.securityfilter.class">edu.institution.organization.SecurityFilter</paran>

<param nane="filter.securityfilter.secretKey">abracadabra</ paranr

<param nane="filter.conpressionfilter.class">edu.institution.organization. ConpressionFilter</paran
<param nane="filter.conpressionfilter.conpressLevel ">5</paranm>

<param name="fil t er mappi ng. securityfilter.1">/secure/ </ paran>

<param nane="fil termappi ng. nyfilter.2">/ speci al / pat h/ </ par an>

<param nane="fi | t er mappi ng. conpressi onfilter.3">/*</ paranr

Email Configuration

KEW can send emails to notify users about items in their Action List (depending on user preferences).
Email in KEW uses the JavaMail library. In order to configure email, you will need to configure the
appropriate JavaMail properties. A list of those properties can be found at the end of the page at the
following url: http://java.sun.com/products/javamail /javadocs/javax/mail/package-summary.html

In addition to these standard JavaMail properties, you can also set the following optional properties to
configure simple SMTP authentication.
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Table 3.6. Optional Propertiesto Configure Simple SM TP Authentication

Property Description Examples/Values
mail.transport.protocol The protocol used to sending mail smtp

mail.smtp.host Thisis the host name of the SMTP smtp.secureserver.net
mail.smtp.username Theusername used for accessto the SMTP server

mail.smtp.password Thepassword used for accessto the SMTP server

Of course, if the authentication required by your mail server is beyond the abilities of the above
configuration, it is possible to override the enEmail Service loaded by the KEW module and implement
acustom email service.

In order for KEW to send out emails, several steps need to be done. In order to have KEW send out
any emails, the “SEND_EMAIL_NOTIFICATION_IND” KNS System Parameter needs to be set to
‘Y’. For emails to real people, the environment code must be set to ‘prd’. If this is not set to ‘prd’,
an email can dtill be sent out to a test address. This test address is set by the KNS System Parameter,
“EMAIL_NOTIFICATION_TEST_ADDRESS’. Emails sent in a test system will only be sent to the
address specified by the EMAIL_NOTIFICATION_TEST_ADDRESS. The “from” address may also be
set with a System Parameter. To do this, set the “FROM_ADDRESS’ System Parameter to the email
address you want the KEW emails sent from. If the FROM_ADDRESS parameter doesn't exist or isn’t
set, it will default to “admin@loca host”.

Periodic Email Reminders
KEW can send emails on a nightly or weekly basis to remind users about items in their Action List
(depending on user preferences). Thefollowing set of parameters configures whether the processesto send
these reminders will run, and at what time(s) of day they will do so.

Table 3.7. Configuration Parametersfor Email Reminders

Property Description Examples/Vaues
email.reminder.lifecycle.enabled Enable periodic KEW reminder emails true
dailyEmail.active Enable daily reminder emails true
dailyEmail.cronExpression Configures the schedule on  which|001**?

the daly reminder emails are

sent - see  org.quartz.CronExpression,

org.quartz.CronTrigger for information about the
format for this parameter

weeklyEmail.active Enable weekly reminder emails true
weeklyEmail.cronExpression Configures the schedule on  which|002?* 2
the weekly reminder emails are
sent - see  org.quartz.CronExpression,

org.quartz.CronTrigger for information about the
format for this parameter

Workflow Preferences Configuration

Workflow users have the ability to update their preferences by going to the “ User Preferences’ page. The
default values for many of these preferences can now be configured.

For example, institutions will commonly override the default action list email preference. By default it's
set to “immediate,” but it can be configured to “no”, “daily”, “weekly”, or “immediate.” The user will still
be able to override the defaults on their User Preferences screen.

Here alist of workflow preferences that can be configured:

<!-- Default Option for Action List User Preferences. -->
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<par am nanme="user Opti ons. def aul t.
<l-- email
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.

<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
<I-- del egatorFilterOnActionList:
Filter Page" -->

<par am nanme="user Opti ons. def aul t.
<par am nanme="user Opti ons. def aul t.
par an»

col or " >whi t e</ par an>

options: no, daily, weekly, immediate -->

enui | " >i nredi at e</ par anm>
notifyPrimary" >yes</paranr

noti f ySecondary" >no</ paranp
openNewW ndow' >yes</ par an»
actionLi st Si ze" >10</ paran®
refreshRate" >15</paranp

showAct i onRequi red" >yes</ paran>

showDat eCr eat ed" >yes</ par an»
showDocunent Type" >yes</ paranp
showDocunent St at us" >yes</ par an>
showl nitiator" >yes</paranr
showDel egat or" >yes</ par an»
showTi t1 e" >yes</ paran®

showWér kgr oupRequest " >yes</ par an>

showC ear FYl " >yes</ paranp

showLast Appr ovedDat e" >no</ par an»

showCur r ent Node" >no</ par an®>
useCQut Box" >yes</ paran®

"Secondary Del egators on Action List

Page" or "Secondary Del egators only on

del egatorFil ter OnActionLi st" >Secondary Del egators on Action List Page</parans
primaryDel egatorFilterOnActionList” >Primary Del egates on Action List Page</

Outbox Configuration

The Outbox is a standard feature on the Action List and isvisible to the user in the Ul by default. When
the Outbox is turned on, users can access it from the Outbox hyperlink at the top of the Action List.

The Outbox is
an Action Item
user action, the

implemented by heavily
the Action
the KEW_OUT BOX_ITM_ T

is deleted from
item is stored in

leveraging existing Action List code. When

table as the result of a
table, using the

Item

org.kuali.rice.kew.actionitem.OutboxltemActionL istExtension object. This object is an extension of
the ActionltemActionListExtension. The separate object exists to provide a bean for OJB mapping.

TheWorkflow Preferencesdetermineif the Outbox isvisible and functioning for each user. The preference
iscalled Use Outbox. In addition, you can configure the Outbox at the KEW level using the parameter tag:

<par am nane="actionl i st. out box" >t rue</ par am>

When the Outbox is set to false, the preference for individual users to configure the Outbox is turned off.
By default, the Outbox is set to true at the KEW level. Y ou can turn the Outbox off (to hide it from users)
by setting the property below to false:

<param name="acti onli st. out box. def aul t. pref erence. on">f al se</ par an>

This provides backwards compatibility with applications that used earlier versions of KEW.

Notes on the Outbox:

 Actions on saved documents are not displayed in the Outbox.

» The Outbox respondsto all saved Filters and Action List Preferences.

* A unique instance of a document only exists in the Outbox. If a user has a document in the Outbox
and that user takes action on the document, then the original instance of that document remains in the

Outbox.

Implementing KEW at your institution

In addition to the previous discussion of KEW configuration, there are a few other aspects relevant to
implementing KEW at your institution.
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Bootstrap data

Because the operation of parts of KEW is dependent on a set of Document Types and Attributes being
available within the system, there is some bootstrap XML that you will want to import. The easiest way
to do thisisto import the files in the following locations using the XML Ingester:

kns/src/main/config/xml/RiceSampleA ppWorkflowBootstrap.xml
kew/src/main/config/bootstrap/edistyle.xml

kew/src/main/config/bootstrap/widgets.xml

These filesinclude the following:

Application constants: cluster-wide configuration settings

Core document types and rules. afew primordial document types and rules are required for the system
to function

Default "eDocLite" styles: these are required if you wish to use eDocL ite

Default admin user and workgroup: these are depended upon (at the moment) by the core document
types and rules, as well asreferred to by the default application constants

Application constants you may want to change:

Config.Application.AdminUserList: this should be set to a space-delimited set of administrative user
names

Workflow.AdminWorkgroup: thisshould be set to aninstitutional adminworkgroup; if thedefault KEW
workgroup serviceis used, this can be left to the default, WorkflowAdmin

Config.Mailer.FromAddress: this should be changed to an address specific to your institution, e.g.
kew@your-university.edu

HelpDeskActionList.nelpDeskActionListName: set to an workgroup at your institution

ApplicationContext: set to the context path of the KEW application, if it differs from the environment
default, e.g. "en-prod” instead of "en-prd"

In the core document types and rules config, you will need to change:

superUserWorkgroupName, blanketA pproveWorkgroupName, and exceptionWorkgroup: should be set
to the administrative group at your institution. If you are using the default workgroup service, this can
be left as WorkgroupAdmin

ensure all docHandler elements, if they specify a URL, specify: "${ base.url}/en-dev/Workgroup.do?
methodToCall=docHandler", and ensure that the base.url config parameter is specified in your
configuration (as mentioned above)

KEW Administration Guide

Thisguide providesinformation on administering aKuali Enterprise Workflow (KEW) installation. Out of
the box, KEW comeswith adefault setup that workswell in devel opment and test environments. However,
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when moving to a production environment, this setup requires adjustments. This document discussesbasic
administration as well as instructions for working with some of KEW’ s administration tools.

Configuration Overview

You configure KEW primarily through the workflow.xml file. Please see the KEW Configuration
Parameters guide for more information on initial configuration of a KEW installation.

Application Constants

Application Constants are the configuration elements in KEW. Each constant is modifiable at system
runtime; any changes take effect immediately in KEW. Application Constants are stored in a cluster-safe
cache and propagated across all machines when change occurs. For more information about Application
Constants, please refer to Application Constants.

Production Environments

When rolling KEW out into a production environment, there are application constants which you may
need to change:

ActionList.sendEmailNotification - Thisis usually set to false in test environments so emails aren’t
generated during testing. Usualy, this is set this to true in a production environment to alow email
notifications. Y ou also need to ensure that your email service is configured properly to allow KEW to
send notifications.

ApplicationContext - In a production environment, thisis usually something like en-prd. Y ou must set
this value correctly so that KEW’ s email notifications contain valid links.

Backdoor.ShowbackDoor L ogin - The backdoor login allows users to masquerade as other users for
testing purposes. It is recommended that you set this value to false in a production environment.

RouteM anager Pool.numW or ker s— The appropriate value for this depends on the capabilities of your
production hardware. If it's set too high, KEW may use so much of the CPU that other applications
running on the same machine are adversely impacted.

RouteM anager Queue.waitTime - In test environments, users tend to be more sensitive to immediate
feedback since they may be testing processes over the course of acouple minutesthat, in practice, occur
over a number of days. In test environments, it is recommended that you keep this value low. In a
production environment, you can reasonably increase this value without affecting the speed at which
documents are routed. This reduces thrashing on the route queue.

RouteQueue.isRoutingByl PNumber - If you are running your production KEW system in a clustered
environment, set this value to false. This allows processing of documents in the queue to be distributed
across the entire cluster, which enhances routing performance and facilitates load balancing.

RouteQueue.maxRetryAttempts - As with the RouteManagerQueue.waitTime constant, in a test
environment it isimportant to find out as quickly as possible if adocument is going to go into exception
routing (usually indicating a problem in that document's routing setup). In a production environment, it
may make senseto allow alonger period before adocument goes into exception routing. This constant,
in combination with the RouteQueue.timel ncrement constant, determines how long it takes a document
to be put into exception routing.

RouteQueue.timel ncrement - Increasing this value results in a longer time before a document goes
into exception routing.
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XML Ingestion
KEW relies on XML for data population and routing configuration. XML Ingester is available from the

Administrator channel in the portal. This allows import of various KEW components from XML, such
as DocumentTypes, RuleAttributes, Rules, Workgroups, and more.

Uploading an eDoclLite form
To upload XML, go to Ingester Ul and select the XML file that you want to import:

Figure 3.5. Ingester

Ingester

XML File: | Choose File | no file selected

XML File: | Choose File | no file selected

XML File: | Choose File | no file selected

XML File: | Choose File | no file selected

XML File: | Choose File | no file selected

XML File: | Choose File | no file selected

XML File: | Choose File | no file selected

XML File: | Choose File | no file selected

XML File: | Choose File | no file selected

XML File: | Choose File | no file selected

upload xml data

After upload, notice the red arrow and the statement, Ingested xml doc: <name of file>:

Figure 3.6. Ingestion Complete

Ingester

= Ingested xml doc: 7-0AA_InterviewRequestEdl.xml

XML File: | Choose File | no file selected

XML File: | Choose File | no file selected

XML File: | Choose File | no file selected

XML File: | | Choose File | no file selected

XML File: | Choose File | no file selected

XML File: | | Choose File | no file selected

XML File: | Choose File | no file selected

XML File: | | Choose File | no file selected

XML File: | Choose File | no file selected

XML File: | | Choose File | no file selected

upload xmi data

Message Queue Administration

The Message Queue is the main scheduling mechanism in KEW. You use it to schedule documents for
asynchronous routing and to queue arbitrary units of work. When KEW places a document into exception
routing, it may become stuck after a series of failed attempts. Y ou can use the Route Queue Ul to resolve
thisissue, aswell asto fix new entries, if needed.
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Examining the Message Queue

The main Message Queue screen:

Figure 3.7. M essage Queue Screen
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Examining this sample screen, we see there are 20 entries in the message queue, one on each row. The
columns display information about each entry:

» Message Queue ld - The primary key of this route queue entry in the data store
» Service Name
» Service Namespace

e |PNumber - ThelP address of the machine on which the entry was created. In the environment pictured,
we havethree machinesin our cluster. The I P number showsfrom which machine each entry was queued

up.
* Queue Status— The entry can bein astate of QUEUED, ROUTING, or EXCEPTION:
¢ A QUEUED entry iswaiting for aworker thread to pick it up.
* A ROUTING entry currently has aworker working on it.

e An EXCEPTION entry has a problem and the route manager cannot access it. An administrator
manually setsan EXCEPTION statusto suspend aroute queue entry until aproblem can be diagnosed.

* Queue Priority - The priority of the entry in the queue, where entries with the lowest number are
processed first

e Queue Date - The date that KEW should process this queue entry. If the queue checker runs and
discovers the queue date for an entry is equal to or earlier than the current time, it processes that entry.

» Expiration Date
* Retry Count - The number of times KEW has attempted to process the entry

» App Specific Value 1 - The parametersto be passed to the Route Queue processor such as document ID
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» App Specific Value 2 - The parameters to be passed to the Route Queue processor
 Action - The Edit link in the Action column allows you to edit the route queue entry.

Once a message entry has been successfully processed, it is deleted from the queue.

Diagnosing and Fixing Problems

Sometimes it is necessary to manually edit a route queue entry that is halted inside of the queue. This
situation might happen when:

» KEW encountersan error trying to put the document into exception routing. Thiscould occur if thereisa
database error or the document's PostProcessor throws an exception when it'snotified of astatus change

» KEW isimproperly shut down in the middle of an entry being processed
» The database goes down while an entry is being processed

In al cases, the status of the entry is ROUTING, but there is no longer a worker thread processing the
entry. Currently, KEW doesn't implement any auto-detection of failure cases. To put one of these entries
in a state where it can be picked up by the route manager again, smply click the Edit link and set the
entry’s status back to QUEUED. Here's a screen shot of the Route Queue Entry - Edit screen:

Figure 3.8. Route Queue Entry Edit Screen

¥ workflow eoue cueue

Route Queus Entry

Existing Route Queue Values New Route Queue Yalues

Route Queus [d: | 1357006 1357006 2
Cocument Id: | 550176 250176
Qusus Priority: | 21 ru_v T

Queue Status: | R il

Queus Dats: | 07/12/2006 0F/12/2008
Ratry Count: | 1
IP Number: | 129.79.210.179 129.79.210.179
Frocessor Class Name:
Frocessor Yalue:

quewe dooument deilete reset clear

Use the Queue Status dropdown list to change the status of the entry. Y ou may also want to set the Retry
Count to zero to allow you to diagnose the problem before the document goes into exception routing.

KEW System Parameters

System Parameters Covered

Table 3.8. KEW System Parameters

Name Vaue Description

MAX_MEMBERS PER_PAGE 20 The maximum number of role or group members to
display at once on their documents. If the number
is above this value, the document will switch into a
paging mode with only this many rows displayed at
atime.

PREFIXES MsMrsMr-Dr

SUFFIXES Jr;Sr;Mr;Md
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Name Vaue Description

CHECK_ENCRYPTION_SERVICE_OVERRIDE_IND Y Flag for enabling/disabling (Y/N) the demonstration
encryption check.

DATE_TO_STRING_FORMAT_FOR_FILE_NAME yyyyMMdd A single dae format string that the
DateTimeService will use to format dates
to be wused in a file name when
DateTimeServicelmpl.toDateStringForFilename(Date)
is caled. For a more technica description of
how characters in the parameter value will be
interpreted, please consult the Java Documentation
for javatext.SimpleDateFormat. Any changes will
be applied when the application is restarted.

DATE_TO_STRING_FORMAT_FOR_USER_INTERFACE MM/ddlyyyy A singledateformat string that the DateTimeService
will use to format a date to be displayed on a
web page. For a more technica description of
how characters in the parameter value will be
interpreted, please consult the Java Documentation
for javatext.SimpleDateFormat. Any changes will
be applied when the application is restarted.

DEFAULT_COUNTRY us Used as the default country code when relating
records that do not have a country code to records
that do have a country code, e.g. validating a zip
code where the country is not collected.

ENABLE_DIRECT_INQUIRIES_IND Y Flag for enabling/disabling direct inquiries on
screens that are drawn by the nervous system (i.e.
lookups and maintenance documents)

ENABLE_FIELD_LEVEL_HELP_IND N Indicates whether field level help links are enabled
on lookup pages and documents.

MAX_FILE_SIZE_DEFAULT_UPLOAD 5M Maximum file upload size for the application. Must
be an integer, optionally followed by "K", "M", or
"G". Only used if no other upload limitsarein effect.

SENSITIVE_DATA_PATTERNS [0-9]{ 9} ;[0-9]{ 3} -[0-9]{ 2} -[0-9]{ 4} A semi-colon delimited list of regular expressions
that identify potentialy sensitive data in strings.
These patterns will be matched against notes,
document explanations, and routing annotations.

STRING_TO_DATE_FORMATS MM/ddlyy;MM-dd-yy;MMMM  dd,|A  semi-colon delimited list of strings
yyyy;MMddyy representing date formats that the
DateTimeService will use to parse dates when
DateTimeServicelmpl.convertToSqgl Date(String) or
DateTimeServicelmpl.convertToDate(String) is
caled. Note that patterns will be applied in the
order listed (and the first applicable one will
be used). For a more technical description of
how characters in the parameter value will be
interpreted, please consult the Java Documentation
for javatext.SimpleDateFormat. Any changes will
be applied when the application is restarted.

STRING_TO_TIMESTAMP_FORMATS MM/dd/yyyy hh:mm a A semi-colon delimited list of strings
representing date formats that the DateTimeService
will use to parse date and times when
DateTimeServicelmpl.convertToDateTime(String)
or

DateTimeServicel mpl.convertToSgl Timestamp(String)
is caled. Note that patterns will be applied in
the order listed (and the first applicable one will
be used). For a more technical description of
how characters in the parameter value will be
interpreted, please consult the Java Documentation
for javatext.SimpleDateFormat. Any changes will
be applied when the application is restarted.

TIMESTAMP_TO_STRING_FORMAT_FOR_FILE_NAME yyyyMMdd-HH-mm-ss-S A singledateformat string that the DateTimeService

will use to forma a date and time

string to be used in a file name when
DateTimeServicelmpl.toDateTimeStringForFilename(Date)
is caled. For a more technica description of

how characters in the parameter value will be
interpreted, please consult the Java Documentation

for javatext.SimpleDateFormat. Any changes will

be applied when the application is restarted.
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TIMESTAMP_TO_STRING_FORMAT_FOR_USER_INTERFACE

MM/dd/yyyy hh:mm a

A singledateformat string that the DateTimeService
will use to format a date and time to be displayed
on a web page. For a more technical description
of how characters in the parameter value will be
interpreted, please consult the Java Documentation
for javatext.SimpleDateFormat. Any changes will
be applied when the application is restarted.

ACTIVE_FILE_TYPES

collectorlnputFileType;
procurementCardl nputFileType;
enterpriseFeederFileSetType;
assetBarcodel nventorylnputFileType;
customerL oadlnputFileType

Batch file types that are active options for the file
upload screen.

SCHEDULE_ADMIN_GROUP

KR-WKFLW:WorkflowAdmin

The workgroup to which a user must be assigned to
modify batch jobs.

DEFAULT_CAN_PERFORM_ROUTE_REPORT IND

If Y, the Route Report button will be
displayed on the document actions bar
if the document is wusing the default

DocumentA uthorizerBase.getDocumentActionFlags
to set the canPerformRouteReport property of the
returned DocumentA